User’s SMART )+,

Manual
Model GX10/GX20/GP10/GP20

Paperless Recorder
First Step Guide

C W
AN
] L

3 —_— p—r— _,'

-

I Contents Basic Operation...........cccocccreecemicserscscesssee s ssnees 37
Turning the Power On and Off...........cccoviiiiiiiineseeccneen 37
INEFOUCHON ..o 1 Setting and Removing SD Memory Cards.......................cccvvee 38
Handling Precautions of the GX/GP ..............cooevvvemererreerreereenees 5 Viewing the Operation Screen (Trend)...................oooovovvveeeeecees 38
SD Memory Card Handling Precautions ...............ccccceeverrereene. 5 Displaying the Menu SCreen.............covvnininnnns 39
Checking the Package Contents Setting the Date and TIME™...........ccceeveiieiireree e 39
Standard ACCESSONIES .........c..ocueveeeeeeceeeeeeeeeeeeeeeeee e Configuring the INPULS ..o 40
Conventions Used in This Manual ..................cc.covververireriereenns 9 Starting Measurement and Recording ..o, 40
Protection of ENVIONMENt .............c.euieiereeeeeieeeneie s 10 Switching between Operation SCreens.............coovniiniinenn. 40
. . Saving Data to USB MemOry ..........ccooeiiiieiinieeseeeseeee e 41
Functional Overview ..........ccccciiiiiciinmmnnnnnnnnnseeeesnnsssaes " Switching the Quick Settings (GP 0n|y) ...................................... 41
OVEIVIEBW ...ttt ee e et eaeeeaaeebeeeaeeenrean 1
A Variety of Source Signals........... N Advanced Operation (Various settings and operation) 42
Expandable Module Construction.......................... M Setting Measurement and Recording Conditions ..............ccc..c...
GX60 Connection and Multichannel Measurement ..................... 1 Setting AlaIMS ...
High-speed Measurement, Dual Interval Measurement (Measurement ~ Alarm DO OUPUL...........cooviiiiiiiiiiiiiiie
17107 = JRT OO .12 Using the Scaling Function (Measuring a flow meter)
Loop Control and Program Control Function (/PG Option)..........12 Using the Scaling Function (Measuring a temperature)............... 44
Data StOrage .......c.coveveveeeieeeieieieieeeeie e .12 Registering and Deleting Favorite Screens..........c.coovvincenne 44
A Variety of Display Functons....... 12 Setting the Measurement Mode............ccccoeemreerecernennns 45
Touch SCreen ........cceeveeevieeeeneenns .13 .
Freehand MESSAGES ..........ov.vveveeeeeeeeeeeseeeeeeeeeeee e 13 Setting the Measurement Mode ...............cooooooviiisiiiiiisiiiiiiniis 45
Versatile Network Functions and SOftWare .....owowoeooo 13 LIMIEAtIONS. ...t 45
Other Funcfions .... - Reconfiguring the GX/GP (Module identification).........46
System Configuration .............ccooeieriiieiee e 15 RECONTIGUANG tE GXIGP ..o 46
Component Names Initializing the GX/GP
GX20/GX10. (Initializing all SEtNGS) .......ccervereeieerieeeee e 46
gigg; g)P(:;())EX -------------------------------------------------------------------------- 1; Saving and Loading Setting Parameters.............c..eovu... 47
.......................................................................... Saving Setting Parameters
GX90XA/GX90XD/GX90YD/GX90WD/GXQOXP/GXQOYNGXQ?ELBJT Loading Setup Parameters
. Web Application ... 48
Operating Procedure...........cccoieeeremninssssnensesees s 20 Starting the Web ApPICEHON ..o 48
Installation and Wiring.........c.cccceeveemensseeeeeeesssssssssssens 22 Closing the Web AppliCation ... 48
INStAIIRtON LOCAHON.......ovvvveersinnsstsns 22 Application SOftWare............cccveecrureeerereresreressseseseseees
Installation Procedure...........c.coooviiiiiiiiiiiceneeee 23 PC System Requirements
External Dimensions and Panel Cut Dimensions........................ 23 LT
INStallAtioN ...
Conngct an GX60 S 25 Starting and Closing Universal Viewer
:R/S.t.a ling and REmOVING VO MOGUIES......c..cccvsvnvssssnssssssssssnns gg Starting and Closing Hardware Configurator............c.cccccceoenene 50
(NG vttt
Setup Menu Map........ccccmiimmminrriee s sssnnes 51

YOKOGAWA ¢ IM 04L51B01-02EN

Yokogawa Electric Corporation 8th Edition






User Registration

Thank you for purchasing YOKOGAWA products.

We invite you to register your products in order to receive the most up to date product
information. To register, visit the following URL.

http://www.yokogawa.com/ns/reg/
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Introduction

Thank you for purchasing the SMARTDAC+ GX/GP
Series Paperless Recorder (hereafter referred to as the
GX/GP). This manual explains the basic operation,
installation, and wiring of the GX/GP.

For details on configuring and operating the GX/GP, see
the “ Paperless Recorder User’s Manual (IM 04L51B01-
01EN) “ provided in electronic format.

For details on the settings and operation of the PID
control module and program control (/PG option), see the
Loop Control Function, Program Control Function (/PG
Option) User’s Manual (IM 04L51B01-31EN), provided as
an electronic manual.

This manual supports the following products.

Model Product Name

GX10/GX20 Paperless Recorder (panel mount type)
GP10/GP20 Paperless recorder (portable type)
GX60 1/0 Base Unit (Expandable 1/0)

Although the display of GX20 is used in this guide,
GX10/GP10/GP20 can be operated similarly.

This manual denotes devices with their product names or
model (e.g. GX60).

To ensure correct use, please read this manual and the
following manuals thoroughly before beginning operation.
For a detailed description of the product, see the
electronic manual.

For specifications, refer to General Specifications.

Paper Manuals

Manual Title Manual No.

Models GX10/GX20/GP10/GP20
Paperless Recorder First Step Guide

IM 04L51B01-02EN
(This manual)

Precaution on the use of SMARTDAC+
(Only delivered with each module or GX60)

IM 04L51B01-91EN

Electronic Manuals
You can download these manuals from the following web

page:
www.smartdacplus.com/manual/en/

Manual Title Manual No.

Model GX10/GX20/GP10/GP20
Paperless Recorder First Step Guide

IM 04L51B01-02EN

Model GX10/GX20/GP10/GP20
Paperless Recorder User’s Manual

IM 04L51B01-01EN

Model GX10/GX20/GP10/GP20/GM10
Communication Command User’s Manual

IM 04L51B01-17EN

SMARTDAC+ STANDARD Universal Viewer
User’s Manual

IM 04L61B01-01EN

SMARTDAC+ STANDARD Hardware Configurator IM 04L61B01-02EN

User’s Manual

Model GX10/GX20/GP10/GP20/GM10
Multi-batch Function (/BT) User’s Manual

IM 04L51B01-03EN

Model GX10/GX20/GP10/GP20
Advanced Security Function (/AS) User’s Manual

IM 04L51B01-05EN

Model GX10/GX20/GP10/GP20/GM10
EtherNet/IP Communication (/E1) User’s Manual

IM 04L51B01-18EN

Model GX10/GX20/GP10/GP20/GM10
WT Communication (/E2) User’s Manual

IM 04L51B01-19EN

Model GX10/GX20/GP10/GP20/GM10
OPC-UA Server (/E3) User's Manual

IM 04L51B01-20EN

Model GX10/GX20/GP10/GP20/GM10
SLMP Communication (/E4) User’s Manual

IM 04L51B01-21EN

Model GX10/GX20/GP10/GP20/GM10
LOG scale (/LG) User’s Manual

IM 04L51B01-06EN

Model GX10/GX20/GP10/GP20/GM10
Loop Control Function, Program Control Function (/PG
Option) User’s Manual

IM 04L51B01-31EN

DXA170 DAQStudio User’s Manual IM 04L41B01-62EN

Precaution on the use of SMARTDAC+ IM 04L51B01-91EN

General Specifications

Title General

specifications No.
GX10/GX20 Paperless Recorder (panel mount type) GS 04L51B01-01EN

GP10/GP20 Paperless Recorder (portable type) GS 04L52B01-01EN
GX60 1/0 Base Unit (Expandable I/0O) / GX90EX Expansion GS 04L53B00-01EN
Module
GX90XA/GX90XD/GX90YD/GX90WD/GX90XP/GX90YA
1/0 modules

GX90UT PID Control Module

GX10/GX20/GP10/GP20 Paperless Recorder

Data Acquisition System GM

Loop Control Function, Program Control Function (/PG
Option)

GS 04L53B01-01EN

GS 04L53B01-31EN

*

The last two characters of the manual number and
general specification number indicate the language in
which the manual is written.

Installing the Java Runtime Environment (JRE)

Download JRE from the following site, and install it.
<http://www.smartdacplus.com/software/en/>

Notes

» The contents of this manual are subject to change
without prior notice as a result of continuing
improvements to the instrument’s performance and
functions.

» Every effort has been made in the preparation of
this manual to ensure the accuracy of its contents.
However, should you have any questions or find any
errors, please contact your nearest Yokogawa dealer.

» Copying or reproducing all or any part of the contents
of this manual without the permission of Yokogawa is
strictly prohibited.

Authorised Representative in the EEA

The Authorised Representative for this product in the EEAis:
Yokogawa Europe B.V.

Euroweg 2, 3825 HD Amersfoort,The Netherlands

Revisions

December 2012  1st Edition December 2014  5th Edition
February 2013 2nd Edition December 2015  6th Edition
May 2013 3rd Edition  June 2017 7th Edition
May 2014 4th Edition =~ November 2017  8th Edition
Trademarks

+ SMARTDAC+ and SMARTDACPLUS are registered
trademark of Yokogawa Electric Corporation.

» Microsoft and Windows are registered trademarks or
trademarks of Microsoft Corporation in the United States
and/or other countries.

* Pentium is a trademark of Intel Corporation in the
United States and/or other countries.

* Adobe and Acrobat are registered trademarks or
trademarks of Adobe Systems Incorporated.

» Kerberos is a trademark of Massachusetts Institute of
Technology (MIT).

* The SD logo is a registered trademark of the SD
association.

+ Company and product names that appear in this
manual are registered trademarks or trademarks of
their respective holders.

» The company and product names used in this manual
are not accompanied by the registered trademark or
trademark symbols (® and ™).

IM 04L51B01-02EN



Manual guide for various items and functions

Imtem, Function Main manual Related manuals
Document name User’s Manual Communication Paperless Recorder
No. IM 04L51B01-01EN Command User’s First Step Guide
Manual IM 04L51B01-02EN
IM 04L51B01-17EN
Standard Communication comand |Installation and Wiring
settings,operation
Safety Precautions, First Step Guide v
Installation and Wiring, IM 04L51B01-02EN
Basic operation of the
GXIGP
basic operation and User’s Manual v
setting of the GX/GP. IM 04L51B01-01EN
Math function (/MT) User’s Manual v
IM 04L51B01-01EN
Report function (/MT) User’s Manual v
IM 04L51B01-01EN
Report Template Function |User’s Manual v
(/MT) IM 04L51B01-01EN
Batch Function User’s Manual v
IM 04L51B01-01EN
Modbus Function User’s Manual v
IM 04L51B01-01EN
DARWIN compatible User’s Manual v
communication function  |IM 04L51B01-01EN
Communication channel |User’s Manual v
function (/MC) IM 04L51B01-01EN
Serial communication User’s Manual v v
function (/C2, /C3) IM 04L51B01-01EN
Advanced security Advanced Security 4 4
function (Part 11) Function (/AS)
User’s Manual
IM 04L51B01-05EN
EtherNet/IP EtherNet/IP v v
Communication (/E1) Communication (/E1)
User’s Manual
IM 04L51B01-18EN
WT Communication (/E2) |WT Communication (/E2) v
User’s Manual
IM 04L51B01-19EN
Aerospace heat treatment |User’s Manual v
(/AH) IM 04L51B01-01EN
Multi Batch Function (/BT) |Multi Batch Function (/BT) 4 4
User’s Manual
IM 04L51B01-03EN
OPC-UA Server (/E3) OPC-UA Server (/E3) v v
User’s Manual
IM 04L51B01-20EN
SLMP Communication (/ |SLMP Communication (/ v v
E4) E4)
User’s Manual
IM 04L51B01-21EN
Custom Display (/CG DXA170 DAQStudio v v
option) IM 04L41B01-62EN
Log Scale (/LG) Log Scale (/LG) 4 4
User’s Manual
IM 04L51B01-06EN
Loop Control Function, Loop Control Function, v v v

Program Control Function
(/PG)

Program Control Function
(/PG Option)

User’'s Manual

IM 04L51B01-31EN

IM 04L51B01-02EN



Safety Precautions

» This instrument conforms to IEC safety class |
(provided with terminal for protective grounding),
Installation Category I, and EN61326-1 (EMC
standard), Measurement Category Il (CAT II).*

* Measurement Category Il (CAT Il) are for the analog
input modules (GX90XA) and PID control mopdule
(GX90UT).

Measurement category Il (CAT Il) applies to
measuring circuits connected to low voltage
installation, and electrical instruments supplied
with power from fixed equipment such as electric
switchboards.

» This instrument is an EN61326-1 (EMC standard)
class A instrument (for use in commercial, industrial, or
business environments). The influence rate (judgment
condition A) in the immunity test environment is within
10 % of the range.

» The general safety precautions described here must
be observed during all phases of operation. If the
SMARTDAC+ is used in a manner not described in
this manual, the SMARTDAC+ safety features may be
impaired. Yokogawa Electric Corporation assumes no
liability for the customer’s failure to comply with these
requirements.

* The SMARTDACH+ is designed for indoor use.

m About This Manual

* Please pass this manual to the end user. We also ask
you to store this manual in a safe place.

» This guide is intended for the following personnel:
Engineers responsible for installation, wiring, and
maintenance of the equipment.

Personnel responsible for normal daily operation of the
equipment.

* Read this manual thoroughly and have a clear
understanding of the product before operation.

» This manual explains the functions of the product. It
does not guarantee that the product will suit a particular
purpose of the user.

m Precautions Related to the Protection, Safety,
and Alteration of the Product

The following safety symbols are used on the product
and in this manual.

A “Handle with care.” To avoid injury and damage to the instrument,
the operator must refer to the explanation in the manual.

Protective ground terminal

Functional ground terminal
(do not use this terminal as a protective ground terminal.)

Alternating current

Direct current
ON (power)

OFF (power)

O—1¢ @

» For the protection and safe use of the product and the
system in which this product is incorporated, be sure
to follow the instructions and precautions on safety
that are stated in this manual whenever you handle the
product.

Take special note that if you handle the product in a
manner that violates these instructions, the protection
functionality of the product may be damaged or
impaired. In such cases, Yokogawa does not guarantee
the quality, performance, function, and safety of
product.

»  When installing protection and/or safety circuits such
as lightning protection devices and equipment for the
product and control system or designing or installing
separate protection and/or safety circuits for fool-proof
design and fail-safe design of the processes and lines
that use the product and the control system, the user
should implement these using additional devices and
equipment.

 If you are replacing parts or consumable items of
the product, make sure to use parts specified by
Yokogawa.

» This product is not designed or manufactured to
be used in critical applications that directly affect
or threaten human lives. Such applications include
nuclear power equipment, devices using radioactivity,
railway facilities, aviation equipment, air navigation
facilities, aviation facilities, and medical equipment. If
so used, it is the user’s responsibility to include in the
system additional equipment and devices that ensure
personnel safety.

» Do not modify this product.

A

WARNING

e Use the Correct Power Supply
Ensure that the source voltage match-
es the voltage of the power supply be-
fore turning ON the power. In the case
of portable type and the GX60 (power
inlet type), ensure that it is within the
maximum rated voltage range of the
provided power cord before connect-
ing the power cord.

o Use the Correct Power Cord and Plug
(Portable Type, GX60 (power inlet
type))

To prevent electric shock or fire, be
sure to use the power cord supplied
by Yokogawa. The main power plug
must be plugged into an outlet with a
protective earth terminal. Do not dis-
able this protection by using an ex-
tension cord without protective earth
grounding.

The power cord is designed for use
with this instrument. Do not use the
power cord with other instruments.

e Connect the Protective Grounding
Terminal
Make sure to connect the protective
grounding to prevent electric shock
before turning ON the power.

The power cord that comes with the
portable type and the GX60 (power
inlet type) are three prong type power
cord. Connect the power cord to a
properly grounded three-prong outlet.

e Do Not Impair the Protective Ground-
ing
Never cut off the internal or external
protective grounding wire or dis-

IM 04L51B01-02EN



A

CAUTION

connect the wiring of the protective
grounding terminal. Doing so invali-
dates the protective functions of the
instrument and poses a potential
shock hazard.

Do Not Operate with Defective Protec-
tive Grounding

Do not operate the instrument if the
protective grounding might be defec-
tive. Also, make sure to check them
before operation.

Do Not Operate in an Explosive Atmo-
sphere

Do not operate the instrument in the
presence of flammable gas, vapors, or
combustible dust. Operation in such
an environment constitutes a safety
hazard. Prolonged use in a highly
dense corrosive gas (H2S, SOx, etc.)
will cause a malfunction.

Do Not Remove Covers

The cover should be removed by
Yokogawa’s qualified personnel only.
Opening the cover is dangerous,
because some areas inside the instru-
ment have high voltages.

Ground the Instrument before Making
External Connections

Connect the protective grounding
before connecting to the item under
measurement or control unit.

Damage to the Protection

Operating the instrument in a man-
ner not described in this manual may
damage the instrument’s protection.
Wiring

To prevent shock, attach the included
terminal cover after wiring. Make sure
to use appropriate wires and crimp-on
lugs.

If hazardous external voltage (30 V
AC or 60 V DC or more) is applied to
the 1/0 terminals, provide adequate
protection to prevent users or service
engineers from suddenly touching
the terminals or tools or the like from
coming in contact with the terminals.

This instrument is a Class A product.
Operation of this instrument in a
residential area may cause radio
interference, in which case the user is
required to take appropriate measures to

correct the interference.
|

m Exemption from Responsibility

Yokogawa makes no warranties regarding the product
except those stated in the WARRANTY that is provided
separately.

Yokogawa assumes no liability to any party for any loss
or damage, direct or indirect, caused by the user or any
unpredictable defect of the product.

m Software Handling Precautions

Yokogawa makes no warranties, either expressed or
implied, with respect to the software’s merchantability
or suitability for any particular purpose, except as
specified in the terms of the separately provided
warranty.

All reverse-engineering operations, such as reverse
compilation or the reverse assembly of the product are
strictly prohibited.

No part of the product’s software may be transferred,
converted, or sublet for use by any third party, without
prior written consent from Yokogawa.

About the Usage of Open Source Software

KT TR RS AR Y 3£

This products uses open source software.
For details on using open source software, see Regarding
the Downloading and Installing

for the Software, Manuals and Labels (IM 04L61B01-
11EN).

IM 04L51B01-02EN



Handllng Precautions of the GX/GP

Use care when cleaning this instrument, especially
its plastic parts. Use a soft dry cloth. Do not use
organic solvents, such as benzene or thinner, or
other cleansers. They may cause discoloring and
deformation.

» Keep electrically charged objects away from the signal
terminals. Failure to do so may damage the GX/GP.

* Do not apply volatile chemicals to the display, panel
keys, etc. Do not allow rubber and vinyl products to
remain in contact with the GX/GP for long periods of
time. Doing so may damage the GX/GP.

* When not in use, make sure to turn off the power
switch.

 If there are any symptoms of trouble such as strange
odors or smoke coming from the GX/GP, immediately
turn off the power switch and the power supply source.
Then, contact your nearest Yokogawa dealer.

SD Memory Card Handling Precautions
SD memory cards are delicate and should be handled
with caution.

* Yokogawa provides no warranty for damage to, or loss
of data recorded on the SD memory card, regardless
of the cause of such damage or loss. Please always
make backup copies of your data.

* Do not store or use the SD memory card in places with
static electricity, near electrically charged objects, or
where electrical noise is present. Doing so can result in
electric shock or damage.

* Do not disassemble or modify the SD memory card.
Doing so can result in damage.

» Do not physically shock, bend, or pinch the SD memory

card. Doing so can lead to malfunction.

» During reading/writing of data, do not turn OFF the
power, apply vibration or shock, or pull out the card.
Data can become corrupt or permanently lost.

* Only use Yokogawa SD memory cards. Operation
cannot be guaranteed with other brands of card.

* When inserting the SD memory card into the
instrument, make sure you orient the card correctly
(face up or down) and that you insert it securely. If not
inserted correctly, the card will not be recognized by
the instrument.

* Never touch the SD memory card with wet hands.
Doing so can lead to electric shock or malfunction.

* Never use the SD memory card if it is dusty or dirty.
Doing so can lead to electric shock or malfunction.

* The SD memory card comes formatted.

SD cards must be formatted according to the standard
established by the SD Association (https://www.sdcard.
org/home). If you want format the SD memory card,
use the instrument’s Format function. If using a PC

to perform the formatting, use the SD card formatter
software available from the above SD Association.

* You can use SD/SDHC cards (up to 32 GB) on the GX/
GP.

SD Memory Card Specifications and Characteristics

Electrical specifications  Operating voltage: 2.7 V to 3.6 V (memory
operation)

Operating temperature / —25 to 85°C / 20 to 85% RH, no condensation
humidity conditions

Storage temperature / —40 to 85°C / 5 to 95% RH, no condensation
humidity conditions

Unit: mm
24 +£0.1
[| DDDDDDDD Writable N\
Qe |
32+0.1
SD l
Write-protected

Checking the Package Contents

After receiving the product and opening the package,
check the items described below. If the wrong items
have been delivered, if items are missing, or if there is a
problem with the appearance of the items, contact your
nearest Yokogawa dealer.

Check that the product that you received is what you
ordered by referring to the model name and suffix code
given on the name plate on the GX/GP.

NO. (Instrument Number)

When contacting the dealer from which you purchased the

instrument, please give them the instrument number.

IM 04L51B01-02EN



MODEL and SUFFIX Codes

GP10/GP20"

GX10/GX20"® Model | Suffix Code |Optional |Description
" " - Code
LA et e EEuEi GP10 Paperless recorder (Portable type,
IS o ol Small display)
X10 g;i?{ﬁfg;:;order (Panel mount type, GP20 Paperless recorder (Portable type,
GX20 Paperless recorder (Panel mount type, T Large display)
: ype -1 Standard (max. no. of measurement
Large display) ch : 100)
Type -1 Standard (max. no. of measurement ch : 100) -
-2 Large Memory (max. no. of measurement 2 Large Memory (max. noizof
: 1412 T measurement ch : 500)
ch : 500) Language | E English, degF, DST (summer/winter
Language E English, degF, DST (summer/winter time)'° guag tim?a)m - degh,
Options /AH Aerospace heat .treatme'nt Power supply 1 100 VAC, 240 VAC 16
/AS Advanced security function > 12V DC 7
;g_? I\Blllsl(t:i‘ftf:t\é:rfunction Power cord E Eower corg \L;IE_)/ECStA s(tjangard
ower cor standar
1c2 RS-232" 3 R Power cord AS standard
fe3 RS'422/4§5 - Q Power cord BS standard
/ICG Custom dlsglay function H Power cord GB standard
/D5 VGA output — N Power cord NBR standard
/E1 EtherNet/IP communication W Screw terminal, power cord not
(PLC communication protocol)'® included ’
/E2 WT communication™ Options /AH Aerospace heat treatment
/E3 OPC-UA server — % IAS Advanced security function
/E4 SLMP communication (Mitsubishi PLC) BT Multi-batch function
/FL Fail output, 1 point /C2 RS-232
Le LOG scale /c3 RS-422/485'
/MT Mathlematb_la:gl function (with report 1CG Custom display function
function) >
P— T /D5 VGA output
/MC Communication channel function /E1 EtherNet/IP communication
1P1 24 VDC/AC power S“PP'V:Z (PLC communication protocol)'®
/PG Program control function E2 WT communication'®
/UH USB Inten‘e.lce (hos;.t 2 ports) : E3 OPC-UA server
/UC[]0 |Analog (unn{ersaal) input module preinstalled E4 SLMP communication (Mitsubishi
(clamp terminal) PLC)2
/US[]0  |Analog (universal) input module preinstalled IFL Fail output, 1 point
(M3 screw terminal)® LG LOG scale’
/ICR[ 1] Digjtal outpl;t module, digital input module IMT Mathematical function (with report
preinstalled function) 15 18
/MC Communication channel function®!
PG Program control function 2
/UH USB interface (host 2 ports)
/UC[]0  |Analog (universal) input module
preinstalled (clamp terminal)®
/US[]0  |Analog (universal) input module
preinstalled (M3 screw terminal)®
/ICR[][] |Digital output module, digital input
module preinstalled®
Models in Which I/O Modules Are Preinstalled
Model Suffix Code |Optional |Description
Code
GX10 |[-cE/N]] Paperless recorder (panel mount type)
GX20
GP10 [-cE1[ ][] Paperless recorder (portable type)
GP20
Options /UC10 With analog input module, 10ch (Clamp terminal)
(analog Input)® ™" /UC20 | With analog input module, 20ch (Clamp terminal)’
/UC30 With analog input module, 30ch (Clamp terminal)®
/UC40 | With analog input module, 40ch (Clamp terminal)®
/UC50 With analog input module, 50ch (Clamp terminal)®
/US10 With 10ch analog input module (M3 screw terminal)
/US20 With 20ch analog input module (M3 screw terminal)’
/US30 With 30ch analog input module (M3 screw terminal)®
/US40 | With 40ch analog input module (M3 screw terminal)®
/US50 | With 50ch analog input module (M3 screw terminal)®
Options /CRO1 | With digital I/O module (output: 0, input: 16)% % 18
(digital 1/0)* /CR10 | With digital I/O module (output: 6, input: 0)
/CR11 | With digital I/O module (output: 6, input: 16)"8 915
/CR20 With digital I/0 module (output: 12, input: 0)°
/CR21 | With digital I/O module (output: 12, input: 16)%° 1
/CR40 With digital I/O module (output: 24, input: 0)°
/CR41 | With digital I/O module (output: 24, input: 16)% 15
6 IM 04L51B01-02EN




1 /C2 and /C3 cannot be specified together. 1/10 Modules
2 /D5 can be specified only for the GX20/GP20.
3 Only one option can be specified. GX90XA
4 Only one option can be specified. o A
5 /ucy40, /ucpso, US40, anZ JUS50 cannot be specified for the GX10/GP10. Model Suffix Code | Description
6  /CR20,/CR21,/CR40, and /CR41 cannot be specified for the GX10/GP10. GX90XA Analog Input Module
7 If /UC20 or /US20 is specified for the GX10/GP10, /CR11 cannot be specified. -04 4 channels (Type -HO only)
8 If JUC30 or /US30 is specified for the GX10/GP10, /CR01, /CR10, and /CR11 Channels -06 6 channels (Type -R1 only)
cannot be specified. -10 10 channels (Type -C1, -L1, -U2, -T1)
9 A digital input module has M3 screw terminals. Current, Scanner type
10  The Display language is selectable from English, German, French, Russian, -C1 (isolated between channels)
Korean, Chinese, Japanese. -
To confirm the current available languages, please visit the following website. DCV/TC/DI (400 VAC, 1 min),
URL: www.yokogawa.com/ns/language/ -L1 Scanner type
11 Solid state relay type (Type Suffix Code: -U2). (isolated between channels)
12 Can be specified only for the GX20/GP20. U2 Universal, Solid state relay scanner
13 To connect an I/O base unit, you will need one 1/0O expansion module for the type (3-wire RTD b-terminal common)
GXIGP. Type DCV/TC/DI, Electromagnetic relay
14 /Sl\éll(;ccisgon must be separately specified when the WT communication is -T1 scanner type (Isolated between
15 Optional code /MT (MATH) required if using the GX90XD's or GX90WD's pulse channels) —
input. -HO ngh—speed universal, individual A/D
16 Selectable only when the power cord suffix code is D or F or R or Q or H or N. type (isolated between channels)
17  Selectable only for the GP10 when the power cord suffix code is W. R1 4.-Wil'e RTD/resistance, scanner type
18  The /MT option (computation) is required to perform pulse integration on (isolated between channels)
GX90XP pulse input modules. - N Always N
19 Ifyou want to write from a PLC to the GX/GP via EtherNet/IP communication, a . -3 Screw terminal (M3)
separate communication channel (/MC) is required. Terminal type C Clamp terminal
20 Ifyou wa_nt t_he GX/GP to load data from_SLMP servers via_SLMP_ Area N |General
communication, a separate communication channel (/MC) is required.
21 If you want to load data from other devices into the GX/GP using Modbus client,
a communication channel (/MC) is required.
22  This is applicable only when a GX90UT PID Control Module is installed. GX90XD
. 1 Model Suffix Code Description
1/0 Base Unit (Expandable 1/0) GXO0XD Digital Input Module
Model Suffix Code |Description Channels -16 16 channels
GX60 1/0 base unit Type 11 Open collector/Non-voltage, contact
Type _EX 1/0 Expansion (shared common), Rated 5 VDC
Area N General - N Always N__
Power supply 1 100 VAC, 240 VAC Terminal type -3| |Screw terminal (M3)
Power cord D_|Power cord UL/CSA standard -C| |Clamp terminal
F_|Power cord VDE standard Area N_|General
R _[Power cord AS standard 1 Optional code /MT (MATH) required if using the pulse input.
Q |Power cord BS standard
H |Power cord GB standard GX90YD
N _|Power cord NBR standard
W |Screw terminal, power cord not included 2 Model Suffix Code Description
1 Include GX90EX (Expansion module), Stopper (antiskid rubber) GX90YD Digital Output Module
2 Intended use for panel or rack mounting only. Channels -06 6 channels
Type -11 Relay, SPDT(NO-C-NC)
) ) - N Always N
1/0 Expansion Module (Expansion Module) Terminal type 3| |Screw terminal (M3)
Model Suffix Code Description Area N |General
GX90EX 1/0 Expansion Module
Port -02 2 ports GX90WD
Type -TP1 Twisted pair cable Model Suffix Code Description
e N N g';a;ZIN GX90WD Digital Input/Output Module '
Channels -0806 Input 8 channels, Output 6 channels
Open collector/non-voltage contact
Type -01 (shared common), rated 5 VDC;
Relay, SPDT (NO-C-NC)
- N Always N
Terminal type -3 Screw terminal (M3)
Area N |General

1 Optional code /MT (MATH) required if using the pulse input.
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GX90XP

Model

GX90XP
Channels -10

Suffix Code Description

Pulse Input Module
10 channels
DC voltage/Open collector/Non-

Type -11 voltage, contact (shared common),
Rated 5 VDC
- N Always N
Terminal type -3 Screw terminal (M3)
-C Clamp terminal
Area N |General

1 The /MT option (computation) is required to perform pulse integration.

GX90YA

Model Suffix Code Description

GX90YA Analog Output Module

Channels -04 4 channels

Type 1 Current output (isolated between
channels)

- N Always N

Terminal type -3 Screw terminal (M3)

P -C Clamp terminal

Area N |General

GX90UT

Model Suffix Code Description

GX90UT PID Control Module

Number -02 2 loops

of loops

Function -11 DI 8 points, DO 8 points

- N Always N

Terminal type -3 Screw terminal (M3)

Area N |General

m Customized Product

For customized product, the product is identified by the
option code of /S# (where ‘# is a number).

Contact your supplier in case your instrument has option
/S#, and you are not in the possession of IM [Model code]-
-S# (where [Model code] means, for example, GX90XA).

Standard Accessories

The instrument is shipped with the following accessories.
Make sure that all accessories are present and
undamaged.

No. |[Name Part Number/Model |Qty. |Notes
1 Mounting B8740DY 2 GX10/GX20 only
bracket
2 SD memory 773001 1 1GB
card
3 Dummy cover |B8740CZ For empty slots
4 Tag plate B8740FE GX20
B8740ME GP20
B8741FE GX10
B8741ME GP10
5 Sheet B8740FF 1 GX20
B8740MF 1 GP20
B8741FF 1 GX10
B8741MF 1 GP10
6 Stylus B8740BZ 1
7 Power cord A1006WD 1 D: Power cord UL,
CSAstd’
A1009WD 1 F: Power cord VDE
std '
A1024WD 1 R: Power cord AS
std’
A1054WD 1 Q: Power cord BS
std’
A1064WD 1 H: Power cord GB
std’
A1088WD 1 N: Power cord NBR
std '
8 Manual IM 04L51B01-02EN |1 First Step Guide (This
manual)
IM 04L61B01-11EN |1 Regarding the
Downloading and
Installing for the
Software, Manuals
and Labels/About
the Usage of Open
Source Software

1 Except GP10 power supply suffix code: 2

Optional Accessories (Sold separately)

Name Part Number/ Minimum. |Notes
Model Q'ty
Mounting bracket B8740DY 2 GX10/GX20 only
SD memory card 773001 1 1GB
Stylus B8740BZ 1
Shunt resistor 415940 1 2500 +0.1%
(for M3 screw terminal) {415941 1 1000 +0.1%
415942 1 100Q0+0.1%
Shunt resistor 438920 1 250 Q +0.1%
(for clamp terminal) 438921 1 1000 +0.1%
438922 1 100Q+0.1%
Dummy cover B8740CZ 1 For module slot
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GX/GP Style Number, Release Number, and
Firmware Version Number

Style number: The GX/GP hardware ID number. This
number is written on the name plate (H
column).

Release number: The GX/GP firmware ID number. This
number is written on the name plate
(S column). This number matches with
the integer part of the firmware version
number.

Example: If the firmware version number is 1.01, the

release number is 1.

Firmware version number:

This number appears on the system
information screen of the GX/GP.

To view the number, see section

2.3, “Displaying Various Types of
Information” in the User’s Manual, IM
04L51B01-01EN.

Conventions Used in This Manual

» This manual covers information regarding GX/GPs
whose display language is English.

* For details on the language setting, see the Paperless
Recorder User’s Manual, IM04L51B01-01EN.

Unit

K: Denotes 1024. Example: 768K (file size)

k: Denotes 1000.

The notes and cautions in this manual are indicated using
the following symbols.

A

Improper handling or use can lead to injury to the user or
damage to the instrument. This symbol appears on the
instrument to indicate that the user must refer to the user’s
manual for special instructions. The same symbol appears
in the corresponding place in the user’s manual to identify
those instructions. In the manual, the symbol is used in
conjunction with the word “WARNING” or “CAUTION.”

WARNING

Calls attention to actions or conditions that could cause
serious or fatal injury to the user, and precautions that can
be taken to prevent such occurrences.

CAUTION

Calls attentions to actions or conditions that could cause
light injury to the user or damage to the instrument or
user’s data, and precautions that can be taken to prevent
such occurrences.

Note
Calls attention to information that is important for proper
operation of the instrument.

Module Notation

When necessary, the following notations are used to
distinguish the GX90XA analog input modules by type.

Type Suffix Code Notation
-U2 Universal
-C1 Current (mA)
-L1 Low withstand voltage relay
-T1 Electromagnetic relay
-HO High-speed universal or High speed Al
-R1 4-wire RTD/resistance
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Protection of Environment

Control of Pollution Caused by the Product

This is an explanation for the product based on “Control of pollution caused by Electronic Information Products” in the
People’s Republic of China.
EFRPESEEYRITENEMRREE

Waste Electrical and Electronic Equipment (WEEE), Directive

N ESEEMRHETE
SN SEEE SE — Y
el ey | RGw | @Od | oOE | BREE | SR_AE
EN I EB X AR N/A N/A N/A v v v
AIERIELL A 1) N/A N/A N/A v v v
T/ HFE R} N/A N/A N/A % v v
&B N/A N/A N/A v v v
1/0 #EHRINT R N/A N/A N/A v v v
ZE N/A N/A N/A v v v
EEBE N/A N/A N/A v v v
Fras (LCD) N/A N/A N/A v v v
FOEMIME/ RLEMME | REIZRE N/A N/A N/A v v v
BB 4% (GP10/GP20/GX60 ( N/A N/A N/A v v v
B O ED)
SD g+ N/A N/A N/A v v v
Sy e PR N/A N/A N/A v v v

v FRoNZEIGH ARV RN N ESE TR T RS BIRTGR/T 26572 tREMMAENIREEK.

N/A: Rz R EDE MR TN ESEEMRE T RS 8i81d68/T 26572 IERMMERREEK.
A=) ER T B B SRoHSIE S R NIR AR, BRAERM G ETZIZIESIRE,

Some parts of this product include the restricted substances of RoHS Directive, but their applications are under the exemption of the directive.

ZIRS AR RIFERHARR, RIESY/T11364, ERATETE (BE. FHE. AN HENEFRS™

BEYBSNESRE M FEIMEIS RS A G W= = EEAFM.
AR ZIRSHRERA “HERIPERIR” , HESROREH. B, XTERIBGHEFEIRE
H, BSRAERRAS.

Equipment (WEEE), Directive. This directive is only valid in the EU.

REEFTZTRNRERERIEEN, ANEREF 2 BEEZIFEATFRA, ToEA~RPH

ﬁ This is an explanation of how to dispose of this product based on Waste Electrical and Electronic
—

Marking

This product complies with the WEEE Directive marking requirement. This marking indicates that you

must not discard this electrical/electronic product in domestic household waste.

Product Category

With reference to the equipment types in the WEEE directive, this product is classified as a “Monitoring
and Control instrumentation” product.

Do not dispose in domestic household waste.

When disposing products in the EU, contact your local Yokogawa Europe B.V. office.

How to Dispose the Batteries
\;gi This is an explanation about the EU Battery Directive This directive is only valid in the EU.

Batteries are included in this product. Batteries incorporated into this product cannot be removed by

yourself. Dispose them together with this product. When you dispose this product in the EU, contact your
local Yokogawa Europe B.V.office. Do not dispose them as domestic household waste.
Battery type: Lithium battery
Notice: The symbol (see above) means they shall be sorted out and collected as ordained in ANNEX Il in
DIRECTIVE 2006/66/EC.
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Functional Overview

IOverview

The GX/GP is a paperless recorder that can display
measured data in real time on its touch screen and save
the data in an SD memory card.

GXIGP configuration

- and real-time monitoring
. onaWeb browser

A variety of
signal inputs
1

Redundant measured data
on internal memory and external media

SD memory card

IA Variety of Source Signals

The GX/GP can connect to DC voltage, TC, RTD, ON/
OFF, DC current (mA) and pulse inputs and measure
temperature, flow rate, and other parameters. The GX/GP
acquires data by sampling input signals at the set scan
interval. The shortest scan interval is 1 ms (High-speed Al
module). Up to four alarm conditions can be specified on
each measurement channel.

IExpandabIe Module Construction
The I/O section is modular, so you can configure your

Detachable module
terminal block

Maintenance is easy!

IGX60 Connection and Multichannel
Measurement

An GX60 I/0 can be connected to the GX20/GP20 to
measure up to 450 channels. On the standard type,

you can connect the GX60 to allocate input sections at
different locations.

. : > Max6

system according to the input types and number of GX60
measurement points.

Modules GX/GP configuration

Model Name Channels Item GXIGP
GX90XA Analog input module 4/6/10 Standard Type Large Memory Type
GX90XD Digital input module 16 Maximum number of 6 6
GX90YD Digital output module 6 connectable GX60 . ,
GX90WD  Digital Input/Output Module  Input: 8 , Maximum number of 10 45
GX90XP Pulse Input Module 10 Maximum number of 100 500
GX90YA Analog output module 4 1/O channels

GX90UT PID Control Module 26

* Up to 10 modules can be installed in the GX20/GP20.
» Up to 3 modules can be installed in the GX10/GP10.
» Different modules can coexist.

* Up to nine modules for the GX20/GP20 and two
modules for the GX10/GP10 when an GX60 is
connected.

1 2 on the rear of the GX10/GP10, 9 on the rear of the
GX20/GP20.
2 9 on the rear of the GX20/GP20.

IM 04L51B01-02EN

1"




Functional Overview

High-speed Measurement, Dual
Interval Measurement (Measurement
mode)

The GX/GP has measurement modes to allow high-speed
measurement and simultaneous measurement of slow
and fast signals.

In high-speed measurement, a high-speed Al module

can be installed to achieve measurement at the shortest
interval of 1 ms.

In dual interval measurement, measurement can be
performed by two measurement groups with different scan
intervals.

Various measurements can be performed by changing the
measurement mode according to the measurement target
and measurement conditions.

ILoop Control and Program Control
Function (/PG Option)

By installing a PID Control Module (GX90UT), you can
perform PID control of up to 20 loops (up to 6 loops for
the GX10/GP10). In addition to control loop monitoring
and the control group screen for convenient operation,
adjustment using the tuning screen is available.

Adding the /PG option to the GX/GP main unit allows

99 patterns and 99 segments of program patterns to be
stored in the main unit. Further, 32 time events can be set.

IData Storage

There are two ways to store data. One way is to record
measured data at all times (display data and event data).
The other way is to record only when events, such as
alarms, occur (event data). Measured data is saved to
the internal memory at the specified interval. Data in

the internal memory can be saved to the SD memory
card automatically or manually. Measured data can

be transferred automatically to an FTP server over an
Ethernet connection.

Auto data transfer to FTP server Ethernet

GX/IGP l—l FTP server

i R SD Memory
Signal input card

IA Variety of Display Functions

Measured data can be displayed in groups as trend
waveforms, values, and bar graphs. There is also an
overview display that you can monitor all channels on a
single screen.

Digital

" o |KChanne 001 hanne _00: Channel 009

0.9869)  0.7526  0.5168

Fame 002 channe 008 [{Chamnel 010
0.9283 0.6934, 0.4570,

Farmel 66| Ghame LG0T hannel 011 =
0.8696 0.6346 0.3948

hanne 004 Channe _008 hannel 012
= 0.8107, 0.5751r 0.3355

Custom Display (Option, /CG)

You can control and monitor on a custom display
consisting of digital, trend, bar graph, and other
components and images can that are laid out freely.
Custom displays are created using DAQStudio (DXA170),
a software application sold separately.

Displays that you create are loaded into the GX/GP from
DAQStudio or from an external storage medium.

Custom Display

Custom Display 2013/12/20 15:31:08 gD 50min lw £
20 -0 0 ey 100 200 30 ]
bt RO oy TOOKTEMES
o Tndp/div]

1531 ~ h
ll =
o

152

Tank Level
88.9|

=
iz

64.5|
= Y
1165

62.5

o

12

IM 04L51B01-02EN



Functional Overview

ITouch Screen

The GX/GP touch screen enables intuitive operation. You
can tap the icons of setup and operation items as well as
scroll and zoom in on and out of waveforms by directly
touching the screen. In addition, when you are working
on-site, you can operate the GX/GP with your gloves on.

Touch Operations

(=)
Recording

GROUP 1

W

7

Y
3 4 5
b ¥ =
oo
borre 2 N o s W owowe s B i

FAVORITE 4 2012/12/15 09:51:06 i PISP
Al channel settings

m AI channel settings Range >

O
B oI chan ans Alarm >
Mafh chl Display settings >
/\/ Dii ay s\ Calibration correction 4
el
é Recording  setting:

I, Data save sel

'Drag

|, Batch setting

Touch the screen with a pen or finger
Report settin|
and move.
[=> Exit \ T
GROUP 1 2012/09/13 10:22:50 afar——o8  [OER 0]
frioo1
3Dsec/ =T 19.0
| |} °c|
P1I001
. 58.1
o kPal
Jr1002
— 39.0
Or = o]
P |
(

i ;\ "\ || Flick
{ —| Wipe a pen or finger across
=TI ~| the screen.

kPal
T1004
79.0
L] °C]
TI005
89.0

7

A
: )
fH‘fHH HHUHW

110:1[7:00[10:18:00[10:

GROUP 1 2012/09/13 10:29:58 aPar———8  [OER L0
‘ ETe YR 5 5 frioo1 13-1

[ ;0:1 =

A Al . 4.2

. } ‘ > ‘ \ T?OOZ SSKP:E
\\ //\ // // // // \\/ \\ \ \//‘ / 0 Fi002 o
S o
%@\% | \ /\/ / 11003 o 4

Pinch apart/together

Touch the screen with two fingers
/\ and move them apart or together.

P e e e et

IFreehand Messages

You can use the touch pen or your finger to write text and
draw marks freely in the waveform area. The messages
that you write can easily be displayed from information
displays such as the message summary and memory

summary.

|
ﬂ
@
<
qj
<

Eraser

7 Fe)
Undo

-

\ = Clear
Separate
Save
Com
A4:27 [12:19:27 [12:14:27 [12:13:27 [12:14:27 [12:19:27 [12:20:27 [12:20:2N[12:: S

(
\
(

(
(

Versatile Network Functions and
Software

The Ethernet interface enables you to monitor the GX/
GP from a Web browser. E-mails can be sent through this
interface when alarms and other events occur.

In addition, you can use the Modbus protocol to read
data from other devices on the network and display it.

As for the software, Universal Viewer can be used to
view measured data and convert the data into other data
formats.

Internet Explorer

Seamless remote monitoringE ‘
on a Web browser

Ethernet R

IM 04L51B01-02EN
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Functional Overview

IOther Functions

Math function
(/MT option)

Expressions can be assigned to
math channels to perform various
computations.

Logic math can output calculated
results as 0 or 1 to DOs or internal
switches. Computation is performed
regardless of the math start/stop
condition.

FAIL output
(/FL option)

This function transmits alarms when
the GX/GP fails.

Security function

You can allow only registered users
to use the GX/GP. In addition, certain
operations can be prohibited.

Remote control

This function executes specified
operations by combining input modules
and the event action function.

Advanced
security function
(/AS option)

A security function that complies with
US FDA 21CFR Part11. Electronic
signatures can be added to measured
data.

EtherNet/IP

This function is equipped with a server

communication (/ function that enables communication

E1 option)

with EtherNet/IP devices.

WT
communication
(/E2 option)

This function acquires measured and
calculated data from a power meter
and displays and records it along with
the measured values of the GX/GP.

LOG scale (/LG
option)

This function measures logarithmic
voltage that has been converted from a
physical value, scales the voltage, and
displays the resultant data.

Aerospace heat
treatment (/AH
option)

Supports aerospace heat treatment
measurements and NADCAP
AMS2750E compliant recording and
reporting.

Manage user-defined schedules for
periodical execution.

Multi batch (/BT
option)

Start and stop recording separately for
each batch and create data files for
each batch.

OPC-UA server
(/E3 option)

Equipped with an OPC-UA server
function. GX/GP measurement data
can be retrieved directly from a host
system, such as SCADA and MES.

SLMP

Equipped with a client function for the

communication (/ MC protocol. Connection to Mitsubishi

E4 option)

Electric PLCs can be established
easily.

14
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Functional Overview

ISystem Configuration

You can configure a GX/GP system as shown below.

YOKOGAWA
Web site

* Download PC software
* Download user’s manuals

PC

- TRy

Ethernet

Power meter Temperature

(WT)

PC

Serial communication*

Network
printer GX20 /" Rs-232, RS-422/485

Signal input »

RTD TC/DCV DI Pulse mA

3-wire/4-wire
£ L3 H A2

Remote input »

Controller

» SD memory card

A
vy

USB port*

Signal output  Alarm output «

Manual DO output

Analog output

Bar code reader

2

FAIL/status output*

Monitor*

Control input
RTD TC/DCV DI

GP10
=

T 7 . —

Yvvy

AAA

A "“ (GX20/GP20 only)

Control output « T
il — [

mA Pulse DCloop power
supply I
b

el

Digital input/output

O out ~ Max 6 unit

Alarm out

Dl input .

* Option

IM 04L51B01-02EN
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Component Names

I cx20/6x10

GX20 front panel GX10 front panel

2012/09/12 09:30:05 gt

LCD
Shows the trend display and other
displays and the setup screen

START/STOP key
Starts and stops recording

MENU key
Press this once to show a menu

for accessing various screens. GX10 rear pane|

Stylus pen (touch pen)

USB port (/UH option)
I— USB2.0 compliant. Connect a USB

Power switch memory device, mouse, keyboard, etc.

SD memory card slot

SD memory card (up to 32 GB)
Format: FAT32 or FAT16

=[: —— - l A1 GB card is included.

= (C—pm— MENU key

Alarms are indicated with a red
LED.

I Front door lock
mechanism
A front door is locked/unlocked

by a slide at the bottom.
GX20 rear panel Lock =

Front door

Use an off-the-shelf door lock key.

1/0 module slot
GX10, GP10: 3 slots (0 to 2)
GX20, GP20: 10 slots (0 to 9)

1/0 module
Connect I/O signals.

Power inlet (GP10/GP20)
Serial port (/C2 option)
RS-232 terminal

Power supply terminal and protective
ground terminal (GX10/GX20)

Serial port (/C3 option)
RS-422/485 terminal

USB port (/UH option)
USB 2.0 compliant. Connect a USB memory device, mouse, keyboard, etc.

Ethernet port
10BASE-T/100BASE-TX port

FAIL output terminal (/FL option)

VGA output connector (/D5 option)
Connects to an external monitor

16
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Component Names

BGr20/GP10

GP20 front

GP20 rear

Handle

| Power inlet J

Feet

GP10 front GP10 rear

(Power supply suffix
code: 2)

B Gx60/GX90EX

GX60 1/0 Base Unit (Expandable 1/0)
1/0 Module Slot GX90EX

Power supply
terminal and
protective ground
terminal or
Power inlet

1 )

|
Stopper (antiskid rubber)
Affix the included antiskid rubber
to the location indicated in the figure .

GX90EX Expansion Module

I_ 7 segment LED

System status LED

Setting switch (DIP switch)

Connecting port
EXBus status LED

IM 04L51B01-02EN
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Component Names

I GX90XA/GX90XD/GX90YD/GX90WD/
GX90XP/GX90YA/GX90UT

GX90XA Analog Input Module

M3 screw terminal

Clamp terminal

Terminal block release levers

GX90XD Digital Input Module

M3 screw terminal

)|

Clamp terminal
-

[[] Terminal block attachment screws

GX90YD Digital Output Module

M3 screw terminal

.

[[] Terminal block attachment screws

GX90WD Digital Input/Output Module
M3 screw terminal

ETerminal block release levers

GX90XP Pulse Input Module

M3 screw terminal Clamp terminal

PULSE INPUT

PULSE INPUT

[[] Terminal block attachment screws

GX90YA Analog Output Module

M3 screw terminal Clamp terminal

ANALOG OUTPU ANALOG OUTP

[[] Terminal block attachment screws

18
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Component Names

GX90UT PID Control Module
M3 screw terminal

Terminal block release levers

.|
To prevent electric shock when you
attach or remove terminal covers or
terminal blocks, be sure that the power
supply is turned off.

WARNING

Removing and Attaching a Terminal Cover
Removing the Terminal Cover

Loosen the screw at the bottom section of the terminal
cover, and remove the cover.

Attaching the Terminal Cover

1. Insert the two hooks at the top section on the inside of
the terminal cover into A, and push the bottom section
of the terminal cover.

2. Fasten the screw at the bottom section of the terminal
cover to fix the cover in place.

Recommended tightening torque: 0.6 Nem

The shape of the cover varies depending on the
module, but the procedure is the same.

Removing and Attaching a Terminal Block
Removing the GX90XA Terminal Block

Push down on the lever at the bottom section of the
module, and pull the terminal block out.
Attaching the GX90XA Terminal Block

Insert the terminal block into the module, and push
the lever firmly against the module (at the position
indicated by the arrow in the figure).

Side view of module
gion | o

<1

fl
L

[ Lh

Terminal block release lever

For modules other than the GX90XA, you can use the
attachment screw to remove and attach them.

Terminal block attachment screws

Recommended torque for tightening the terminal block
attachment screws: 0.1 Nem

IM 04L51B01-02EN

19



When you are using the GX/GP for the first time, following the procedure below to quickly start measuring and recording.

Operating Procedure

Product user’'s manuals can be downloaded or viewed at the
following URL;

URL: www.smartdacplus.com/manual/en/

P> Manuals for reference

P> First Step Guide (This manual)
(IM 04L51B01-02EN)
“Installation and Wiring”
Connect an GX60

P> First Step Guide (This manual)
(IM 04L51B01-02EN)
“Installation and Wiring”
Installing and Removing
I/0O Modules

P> First Step Guide (This manual)
(IM 04L51B01-02EN)
“Installation and Wiring”
Wiring

P> First Step Guide (This manual)
(IM 04L51B01-02EN)
“Basic Operations”
Turning the Power On
and Off

P> First Step Guide (This manual)
(IM 04L51B01-02EN)

“Setting the Measurement Mode”
Setting the Measurement Mode

P> First Step Guide (This manual)
(IM 04L51B01-02EN)
“Reconfiguring the
GX/GP”

D> First Step Guide (This manual)
(IM 04L51B01-02EN)
“Basic Operations”
Setting the Date and Time

P> First Step Guide (This manual)
(IM 04L51B01-02EN)
“Basic Operations”
Configuring the Inputs

> Paperless Recorder
User' s Manual (Electronic Manual)
(IM 04L51B01-01EN)

> First Step Guide (This manual)
(IM 04L51B01-02EN)
“Basic Operations”
Starting Measurement
and Recording

01§

Connect an GX60 )

eUEEEEEEEEEEEEEEEENEEEEEEEEEEEEEEEESE

Install modules. :
L

L

@onnect I/O signals and poweD

@

@(

U EEEE NN NN NN NN NS SN EEEEEEEEEEEEEE,

: Setting the Measurement Mode:

Turn on the power. )

@

NSNS NN N NS EENEEEEEEEEEEEER

Make the GX/GP recognize the
modules (GX/GP reconfiguration).

wasmEEE,

(&)

eanmmmmEn

)

— Set the date and time.*

Configure signal inputs. )

@)

e"NEEEEEEEEEEEEEEE Y AN EEEEEEEEEEEEEEEY

: Configure functions as
: necessary.

asmmmmmn

=

— Start measuring/recording.

To connect an GX60.

Not required if preinstalled
To connect an GX60,
install the modules in the GX60.

When performing high-speed or dual interval
measurement according to measurement
conditions, change the measurement mode from
Normal to High speed or Dual interval.

If preinstalled, modules are preconfigured.
If you rearrange the modules, connect an
GX60 or change the measurement mode,
reconfigure.

* If you need to set the time zone or
DST (Daylight Saving Time) or both, do
so before setting the date and time.

For details on various settings, see the Paperless
Recorder User’ s Manual (IM 04L51B01-01EN),
provided as an electronic manual.
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Operating Procedure

(4 )
7 Installan expansion module 2 GX60 address setting 3 Connect the LAN cable bteween GX/GP
(GX90EX) into the GX/GP.
[+ P Setting switch
b e | (DIP switch)
GX90EX ;
GX10/GP10 : Slot 2
GX20/GP20 : Slot 9 GX90EX
\ J
E 2 Insert until a click is heard 3 Modules installed
- and fasten with screws.* (10 modules) .
. —— :
E Dummy covers are E
. attached to empty slots .
. (with screws). :
E - * Recommended tightening E
. Ex GX/GP torque: 0.6 N-m I I :
) B
Ex GX/GP "
) To prevent electric shock when

Power inlet on the GP10/ wiring, make sure that the power

GP20/GX60 (Power inret supply is turned off.

type)
\ J J

~

S P P I ©

Report (001)

%

.
— 12
Date/Time

setting Setting
Set the measurement
mode
Reconfiguration
(Initialize) Common menu tab Browse tab
Start measu ring/recording. Recording stopped gf:;rfs"s‘g in
V foroue 1 E |
= 'l Bl
S y Alternates
Lit in blue Lit in red
or Running Alarm activated|

5 (0 (&

@ (No alarm)  Off: Power off

7

Initialize

Calibration To open, push the front door down and pull it toward you.
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Installation and Wiring

Ilnstallation Location

Install the GX/GP indoors in an environment that
meets the following conditions:

A\

WARNING

If hazardous external voltage (30 V AC or 60 V DC or
more) is applied to the output terminals of the GP10/
GP20/GX60, be sure to install it in a location where
people cannot touch the terminals carelessly or in a
panel.

The GX10/GX20 is designed to be installed in an

instrumentation panel.

This product is designed as open equipment under the

CSA/UL/EN 61010-2-201 standards. In order to comply

with these standards, install it as follows:

» The GX10/GX20 is designed to be installed in an
instrumentation panel.

Install it in a location where people cannot touch the
terminals carelessly.

» To make the GP10/GP20 comply with the relevant
standard, support the parts of the device other than
the front-panel control area with an instrumentation
panel or the like, and install it in a location where
people cannot touch the terminals carelessly or in a
panel.

* Install the GX60/GM unit in a panel with a door.

» The instrumentation panel or panel used for support
must comply with CSA/UL/EN 61010-2-201 or must
be at least IP1X (degrees of protection) and at least
IK09.

|
To make panel door lock for GX10/GX20
or install the GP/GX60 systems in a
panel with a door or in a location where
operator or any third person can not
operate the power switch carelessly.
When the power switch of GX/GP
systems under operation be turned on or
off carelessly , it may result the system
down or injury.

Careless operations can be avoided by

applying the slide lock.
I

Well-ventilated location

To prevent overheating, install the GX/GP in a well-
ventilated location. For the panel cut dimensions when
arranging multiple GXs, see the next page. When
other instruments are installed next to the GX, follow
the panel cut dimensions to provide adequate space
around the GX. In the case of the portable type, we
recommend that you provide at least 50 mm of space
from the left, right, and top panels.

Nofte

Minimal mechanical vibrations

Install the GX/GP in a location that has minimal
mechanical vibrations. Installing the GX/GP

in a location that is subject to large levels of
mechanical vibration will not only put added stress
on its components, it may also impede ordinary
measurement.

Level Location

Install the GX/GP in a level location so that it is not
slanted to the left or the right (however, the GX/GP
can be inclined up to 30 degrees backward for panel
mounting).

Condensation may form when moving the GX/GP from
a low temperature or humidity environment to a high
temperature or humidity environment, or when there is a
sudden change in temperature. Temperature or humidity
changes may also result in thermocouple measurement
errors. In these kinds of circumstances, wait for at least
an hour before using the GX/GP, to acclimate it to the
surrounding environment.

The GP20 may tip over if it is tilted more than 10
degrees, front and back.

Do Not Install the Instrument in the Following Places

Outdoors

In direct sunlight or near heat sources

Install the GX/GP in a place that is near room
temperature (23°C) and that is not subject to large
temperature fluctuations. Placing the GX/GP in direct
sunlight or near heat sources can cause adverse
effects on the internal circuitry.

Where an excessive amount of soot, steam, moisture,
dust, or corrosive gases are present

Soot, steam, moisture, dust, and corrosive gases will
adversely affect the GX/GP. Avoid installing the GX/GP
in such locations.

Near strong magnetic field sources

Do not bring magnets or instruments that produce
electromagnetic fields close to the GX/GP. Operating
the GX/GP near strong magnetic fields can cause
measurement errors.

Where the display Is difficult to see

The GX/GP uses an LCD screen, so it is difficult to
view the display from an extreme angle. Install the GX/
GP so that the user can view the display directly from
the front.
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Installation and Wiring

Ilnstallation Procedure

A .

CAUTION

Using more than the appropriate
torque to tighten the screws can de-
form the case or damage the brackets.
e Be sure not to insert foreign objects
or tools into the case through the
mounting bracket holes.
* When you attach the rubber pack-
ing, be sure that no portion of it gets
wedged between the GX and the
panel. If the rubber packing is not
attached properly, you will not be able
to achieve sufficient dust proofing or

waterproofing.
|

Installation Procedure for the GX10/GX20
Use a steel panel that is 2 mm to 26 mm thick.

1 Insert the GX through the front of the panel.

2 Mount the GX to the panel using the included

mounting brackets as described below.

» Use two mounting brackets to support the top and
bottom or the left and right sides of the case (remove
the stickers that are covering the holes before you
attach the brackets).

» The recommended tightening torque for the mounting
screws is 0.7 to 0.9 Nem.

» Follow the procedure below to mount the GX to the
panel.

» First, attach the two mounting brackets and
temporarily tighten the mounting screws.

» Next, fix the GX in place by tightening the mounting
screws with the appropriate torque. When the GX is
approximately perpendicular to the panel, press the
mounting brackets so that they are in contact with
the case, and fully tighten the mounting screws.

Nofte

To achieve sufficient dust proofing and waterproofing,
mount the GX in the middle of the panel cut out.

Installation Procedure for the GX60
Use a steel panel that is at least 2 mm thick.

1 Make 6 holes in the panel for the six M4 screws.

2 Fix the unit in place by fastening M4 screws to

the six mounting screw holes. The recommended
tightening torque for the screws is 0.7 to 0.9Nem.

IExternaI Dimensions and Panel Cut
Dimensions

GX20 External Dimensions

280.2 (11.03)

Unit: mm (approx. inch)
Unless otherwise specified,
tolerance is *3% (however,
tolerance is £0.3 mm when
below 10 mm).

(Dimensions before attaching
the mounting bracket)

219.2 max. (8.63) (*1)
295.2 (11.62) 1688 (665)(2) | —
288 (11.34) 28.2 152.6 (6.01) <
144 (5.67) (11| [ 2to26 <
TAllowable i
_ lpanel hick
g8 =8 |2
oS S
HRIE EE | ||®
Ol T
32.3 (1.27) 5
247.4(9.74) s
Panel cut dimensions . . L2
- (Dimensions after attaching
360 min. the mounting bracket)
(14.17) e e
" *1: With modules
*2: Without modules
281"
(17.06) 361 min. (14.21)
281
(11.06)

IM 04L51B01-02EN
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Installation and Wiring

GX10 External Dimensions

136.5

Unit: mm (approx. inch)
Unless otherwise specified,
tolerance is *3% (however,
tolerance is £0.3 mm when
below 10 mm).

(Dimensions before attaching
the mounting bracket)

Max 224.4 (8.83) (*1)
151.5 (5.96) 1731 (6.81) (2
.5 (5. =
144 (5.67) 22.8(0.90)  157.7 (6.21) g
40.9 (1.61) 2t0 26 3
[ ‘IPaneI hick
R
€ sl o5
© I < 36
- IS : ce
;. = - - el - ”ﬁm Y
=]
1| 1033 26.6 (1.05) =
(4.07) ~e
(Dimensions after attaching
the mounting bracket)

Panel cut dimensions

*1: With modules
*2: Without modules

Single-unit Side-by-side mounting
mounting (horizontally)
1373 _ _
(5.39)
B . 175 min. (6.89)
| |63 137" B
t (5.39)
3
L'3
Side-by side mounting
(vertically; max. 3 units)
1373 Units | L7
(5-39) 2 282 (11.10)
3 426 (16.77)
4 570 (22.44)
5 714 (28.11)
w2 6 858 (33.78)
! to| Y [T7 1002 (39.45)
8 1146 (45.12)
9 1290 (50.79)
10 1434 (56.46)
n (144%n)-6
175 min, |
(6.89)

GP20 External Dimensions

288 (11.34)
-
=
[ P P | S [
0 U\ Unit: mm (approx. inch)
m i Unless otherwise specified,
(o Je] tolerance is ¥3% (however,
| tolerance is £0.3 mm when
below 10 mm).
5 MAX 2472 (9.73) (1) &
288 (11.34) = 196.8 (7.75) (*2) =
C ] | [ —] d
.
g g
T - | E
00 ==k
= ____ G|
'm v 111 11 |
NI =
N N
= s

*1: With modules
*2: Without modules

GP10 External Dimensions
143.6 (5.65)

Unit: mm (approx. inch)
Unless otherwise specified,
tolerance is +3% (however,
tolerance is £0.3 mm when

. . below 10 mm).
———
(*1)
. Max 247.2 (9.73) ‘
144567 Zls 196.8 (7.75)(2)
o) T =) [ | —a | ] ‘
oo
< |~
S
i _ u::olf 1 .
'z
0 B
T e *1: With modules

*2: Without modules

When using the stand, the GP10 will face 12 degrees
upward.
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Installation and Wiring

GX60 Dimensions

Power supply terminal type

i ]

4125 (16.2)

48 , 156 (6.14) 162 (6.38)
(1.89), 6-d5 hole

(6-30.2) hole .
LG B
ol EE| 51 ~
| S T Y I 1 o] [
1| 1Ll | 1] 1L [T e —
© 3 127.8 (5.03
S5
Power inlet type
L -
4125 (16.2)
48 . 156 (6.14) 162 (6.38)
(1.89) 6-®5 hole
(6-00.2) hole ‘
ARG AG ]z &
AT LI o LI of———-
. 127.8 (5.03)

Mounting hole dimensions

156402 162102
4 (6.14£0.0078) ¢ (6.38£0.0078)

6-94.5 hole or M4
(6-90.18) hole or M4

148£0.4
(5.830.0157

o o

With modules

412.5(16.2)
48 . 156 (6.14) 162 (6.38)
(1.89) 6-05 hole
(6-90.2) hole
= o
i E! R
i g o| ™~
H @ 1@ 1@ ® ® 3 §
Lo] ] ol

147 (5.79)

87
(0.34)

Unit: mm (approx. inch)
Unless otherwise specified, tolerance is *3% (however,
tolerance is £0.3 mm when below 10 mm).

IConnect an GX60

Installing an Expansion Module into the GX/GP

When installing an expansion module into the GX/GP or

setting dipswitches, turn off the GX/GP and the GX60.

1 Install an expansion module into slot 9 or 2 of the
GX/GP.

2 Set dipswitch 8 of the expansion module to “ON”

(master).
Set the unit number to 0.
(Default: 0)

o
z

S NwAE OB N®

afililllili

Setting the Unit Number of the GX60

The factory default unit number of the expansion module
is 0. Use dipswitches 1 to 4 to set the unit number (1 to 6).

ON

sl slills

S Nw s oo N®

Unit number and dipswitch setting

Unit number Dipswitch
1 2 3 4
6 OFF ON ON OFF
5 ON OFF ON OFF
4 OFF OFF ON OFF
3 ON ON OFF OFF
2 OFF ON OFF OFF
1 ON OFF OFF OFF
o' OFF OFF OFF OFF

1 The factory default setting. Unit number “0” is
reserved for the expansion module that is installed
into the GX/GP.

Fixing the Data Rate to 10 Mbps
To fix the data rate to 10 Mbps, set dipswitch 7 to “ON”.

7-segment LED for
-
=1
L]

o

N 10 Mbps fixed mode
[y

. L?J

Dot indication

ilifilis

IM 04L51B01-02EN
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Installation and Wiring

Connect an GX60

Connect the expansion module installed in the GX/GP
to the expansion modules of each expansion unit using
Ethernet STP (shielded ) cables.

Only cascaded connection is supported.

Maximum communication distance is 100 m. Distance
extension through HUB connection or LAN repeaters is
not possible.

I_ GX90EX

GX60

Functions of Expansion Module Components

7 segment LED

System status LED

Setting switch (DIP switch)

= ——— Connecting port
- I EXBus status LED

7 segment LED

Displays the unit number and operation errors of the GX/

GP and GX60

* Unit number indication
Displays the unit number (00 to 06).

» Operation error indication
Displays error codes. Ex (where x is a one digit number
or an alphabet letter) will blink. For details on error
codes, see “Expansion Module Error Codes” in section
5.2.1, “Messages” of the User’s Manual (IM 04L51B01-
01EN).

*

If an “Fx” indication is displayed, servicing is
necessary. Contact your nearest YOKOGAWA
dealer for repairs.

System Status Display LED

Three LEDs indicate the operating status of the expansion
module.

Setting Switches (Dipswitches)

Use the dipswitches to set the unit number of the GX60,
10 Mbps fixed mode, and operation mode.

Dipswitch settings

Dipswitch Description

8 Switches between master 1/0 expansion and slave
1/0 expansion mode

7 10 Mbps/100Mbps

6 Always OFF (cannot be changed)

5 Always OFF (cannot be changed)

4 For unit number

3

2

1

Port

The port is used to connect the GX60 to the GP/GX. Only
cascaded connection is supported.

Ilnstalling and Removing I/0 Modules

Installing a Module

1. As shown below, insert the module into the GX/GP slot
and the GX60 slot.

2. Push the module in until you hear a click. Then, fasten
the screw at the bottom section of the module.*

Ex. GX/GP

* Recommended torque for tightening the screws: 0.6 Nem
Removing a Module
1. Loosen the screw at the bottom section of the module.
2. While pressing down on the latch at the top of the
module, pull the module out.

Status display LED |Color |Description
RDY Green |llluminates during normal
operation. Turns off when during
a failure.
MAIN Green |llluminates during master 1/O
expansion operation.
FAIL RED llluminates during an error.
26 IM 04L51B01-02EN



Installation and Wiring

Limit to the Number of GX/GP Main Unit Modules
* When GX90XA-04-HO and GX90YA are included

GX10 GP10 GX20-1 |GP20-1 |GX20-2 |GP20-2

No limit__ |No limit* 9 9 9 9

*

Up to two modules for 12 V DC models (power supply
suffix code: 2)

« When GX90UT is included

GX10 GP10 GX20-1 |GP20-1 |GX20-2 |GP20-2

No limit _|No limit* 8 8 8 8

*

Up to two modules for 12 V DC models (power supply
suffix code: 2)

Limit on Modules

* Up to 10 modules consisting of GX90YD, GX90WD,
and GX90UT can be installed into the system.

*  One GX90WD module can be installed in a GX. One
module can be installed in a GX60 (expandable 1/0O)
and each GM sub unit.

*  One GX90YA module can be installed in a GX10. Two
modules can be installed in each of the GX20, GX60
(expandable I/O) and GM sub unit.

* Up to 10 GX90YA modules can be installed in a GX10/
GX20-1 system and up to 12 in a GX20-2 system.

+ If the measurement mode is High speed, only
GX90XA-04-HO (high-speed Al), GX90XD (DI), and
GX90WD (DIO) are detected. DI and DIO are fixed
to remote mode. Measurement and recording are not
possible.

« |If the measurement mode is Dual interval, GX90UT is
not detected.

Notes on Module Installation

»  When the reference junction compensation of this
product is used with the thermocouple input of a
GX90XA-10-U2, GX90XA-10-L1, GX90XA-10-T1 or
GX90XA-04-HO, if the following module is installed to
the right (slot with the smaller number) of the GX90XA
module as seen from the GX rear panel, the reference
junction compensation accuracy of that module may
deviate from the guaranteed range (except when
GX90XA-04-HO is installed to adjacent slots).
GX90XA-10-C1, GX90XA-04-HO, GX90WD, GX90YA,
GX90UT

* On the GX20, when the reference junction
compensation of this product is used with the
thermocouple input of a GX90XA-10-U2, GX90XA-
10-L1, GX90XA-10-T1, or GX90XA-04-HO, if the
following module is installed above, below, to the
right, or to the left (slot with the smaller number) of
the GX90XA module as seen from the GX rear panel,
the reference junction compensation accuracy of that
module may deviate from the guaranteed range.
GX90YA, GX90UT

Channel Names

A channel name consists of a unit number, slot number,
and channel number.

GXI/GP: (Fixed) Channel name

GX60: 1to 6 DDEE

Slot number

Channel number

1/0 modules

GX20/GP20

Rear

IM 04L51B01-02EN
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IWiring
* To prevent electric shock while wiring,
make sure that the power supply is
WARNING turned off.

G

If a voltage of more than 30 VAC or

60 VDC is to be applied to the output
terminals, use ring-tongue crimp-on
lugs with insulation sleeves on all
terminals to prevent the signal cables
from slipping out when the screws be-
come loose. Furthermore, use double-
insulated cables (dielectric strength
of 2300 VAC or more) for the signal
cables on which a voltage of 30 VAC
or 60 VDC or more is to be applied.
For all other signal cables, use basic
insulated cables (dielectric strength of
1390 VAC). To prevent electric shock,
attach the terminal cover after wiring
and make sure not to touch the termi-
nals.

Applying a strong tension to the input
and output signal cables connected to
the GX/GP may damage the cables or
the GX/GP terminals. To avoid apply-
ing tension directly to the terminals,
fix all cables to the rear of the mount-
ing panel.

To prevent fire, use signal cables with
a temperature rating of 70°C or more.
To avoid damage to the GX/GP, do not
apply voltages that exceed the follow-
ing values to the input terminals.

X90XA

Allowable input voltage: +10 V DC

for TC/DC voltage (1 V range or less)/
RTD/DI (Contact), DC mA

160 V DC for DC voltage (2 V to 50

V range), DI (voltage) input (except
High-speed Al)

*#120 V DC for DC voltage (2 to 100

V range ) input , DI (voltage) (High-
speed Al)

Common mode voltage: 60 VDC (un-
der measurement category Il condi-
tions)

%300 VAC rms (under measurement
category Il conditions (High-speed Al)

GX90XD, GX90WD

Allowable input voltage: +10 VDC

GX90XP

G

Allowable input voltage: £10 VDC

X90UT

Allowable input voltage: #10 V DC

for TC/DC voltage (1 V range or less)/
RTD/DI (Contact), DC mA

+60 V DC for DC voltage (2 V range or
more), DI (voltage)

Common mode voltage: 60 VDC (un-
der measurement category Il condi-
tions)

The GX/GP is an installation category Il

product.

Precautions to Be Taken While Wiring

Take the following precautions when wiring the input/
output signal cables.

With a screw terminal, we recommend that you use a
crimp-on lug with an insulation sleeve (M4 for power
supply wiring, M3 for signal wiring).

Crimp-on lug with an insulation sleeve

N1.25-MS3
(JST Mfg. Co., Ltd.)

Recommended signal
wiring crimp-on lug

With a clamp terminal, we recommend the following
wire.

GX90XA

Cross-sectional area  0.05 mm? to 1.5 mm? (AWG30 to 16)
Stripped wire length 5to 6 mm

GX90XD, GX90XP, GX90YA

Cross-sectional area 0.2 mm? to 1.5 mm? (AWG24 to 16)
Stripped wire length 9to 10 mm

RS-422/485 (/C3 option)
Cross-sectional area
Stripped wire length

0.2 mm? to 1.5 mm? (AWG24 to 16)
6to 7 mm

FAIL output/status output (/FL option)

Cross-sectional area  0.33 mm? to 2.0 mm? (AWG22 to 14)
Stripped wire length 10 to 11 mm

Take measures to prevent noise from entering the

measurement circuit.

* Move the measurement circuit away from the power
cable (power circuit) and ground circuit.

+ |deally, the object being measured should not
generate noise. However, if this is unavoidable,
isolate the measurement circuit from the object.
Also, ground the object being measured.

+ Shielded wires should be used to minimize the noise
caused by electrostatic induction. Connect the shield
to the ground terminal of the GX/GP as necessary
(make sure you are not grounding at two points).

« To minimize noise caused by electromagnetic
induction, twist the measurement circuit wires at
short, equal intervals.

» Make sure to earth ground the protective ground
terminal through minimum resistance.

When wiring input/output signal cables, observe the

minimum bend radius of the cables. For the minimum

bend radius, use the specifications indicated by

the input signal cable manufacture or six times the

conductor diameter of the input/output signal cable,

whichever is larger.

When using internal reference junction compensation

on the thermocouple input, take measures to stabilize

the temperature at the input terminal.

» Always use the terminal cover.

» Do not use thick wires which may cause large heat
dissipation (we recommend a cross sectional area of
0.5 mm? or less).

* Make sure that the ambient temperature remains
reasonably stable. Large temperature fluctuations
can occur if a nearby fan turns on or off.

28
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Installation and Wiring

» Connecting the input wires in parallel with other
devices can cause signal degradation, affecting all
connected devices. If you need to make a parallel
connection, then
» Turn the burnout detection function off.

* Ground the instruments to the same point.

* Do not turn ON or OFF another instrument during
operation. This can have adverse effects on the
other instruments.

* RTDs cannot be wired in parallel.

Wiring Procedure

Aterminal cover is screwed in place on the I/O terminal
block. A label indicating the terminal arrangement is
affixed to the cover.

1. Turn off the GX/GP/GX60, and remove the terminal cover.
2. Connect the signal cables to the terminals.

Recommended Screw terminal 0.5 to 0.6 Nem
torque for (M3)

tightening the Clamp terminal  GX90XA: 0.4 N°m
screws GX90XD: 0.5 Nem

GX90XP: 0.5 N*m

3. Attach the terminal cover and fasten it with screws. The
appropriate tightening torque for the screws is 0.6 Nem.

Inside dimension of M3 screw terminal block

& If® & Iapprox. 6 (0.23) mm

Unit: mm (approx. inch)

Wiring Clamped Terminals

Screw
terminal

Wire ¢
; ; ¢/ Flat-blade screwdriver
St d ZPN
(Stripped wire) < g e
\
©

First, loosen the screw at the front using a flat-blade
screwdriver. Insert the input signal wire into the slit on the
left side of the terminal block, and fasten the screw at the
front.

Nofte

With a clamp terminal, if you use a single wire whose
diameter is 0.3 mm or less, you may not be able to clamp
the wire securely to the terminal. Take measures to
securely clamp the wire such as by folding the conductor
section that will be connected to the clamp terminal in half.

Wiring to a GX90XA Analog Input Module

Universal/Low withstand voltage relay/
Electromagnetic relay/Current (mA) type

Terminal Diagram

M3 screw terminal Clamp terminal

CH1
29| cHa
‘ 203
CH4
CH6
P | cHio O
3102107110 - |214|CH10

~&¢— Wiring direction ~&¢— Wiring direction

Wiring Diagram

DC voltage input/DI (level) DI (contact)

® 1@ i@ jlg. ® I®
_I_IIJ+ m 9 LO/DJ
TC input
+(mWe
_I9
.
DC current input

(with an external shunt
resistor)

current input

/ e e IR
o gy N A
- - 1+ med
[
Type Input type Wiring
-U2 DC voltage, thermocouple |1, 2, 3,4,5
(TC), resistance temperature
detector (RTD), DI (voltage,
contact), and DC current (by
adding an external shunt
resistor)
-C1 DC current (mA) 6
-L1 DC voltage, thermocouple |1, 2, 3,5
-T1 (TC), DI (voltage, contact),
and DC current (by adding
an external shunt resistor)

Terminal Arrangement
M3 screw terminal

CH Term. |Symbol |Term. |Symbol [Term. [Symbol
No. No. No. No.

CH1 [301 b’ 201 |-/B 101 [+/A
CH2 [302 b’ 202 |-B 102 [+/A
CH3 [303 b’ 203 |-/B 103 |+/A
CH4 [304 b’ 204 |-/B 104 |[+/A
CH5 [305 b’ 205 |-B 105 |+/A
CH6 [306 b’ 206 |-/B 106 |+/A
CH7 307 |b' 207 |-B 107 [+/A
CH8 [308 b’ 208  |-/B 108 |+/A
CH9 [309 b’ 209 |-B 109 [+/A
CH10 [310 b’ 210 |-/B 110 |+/A
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Installation and Wiring

Clamp terminal Terminal Arrangement
CH No. [Term.No.| Symbol | CH No. | Term.No. Symbol M3 screw terminal
201 +A 101 +A CH Term. |Symbol |Term. Symbol |Term. |Symbol
CH2 | 202 /B CH1 | 102 /B No. INo. No. No.
203 b 103 b CH1 | 301 /A_ 1201 | b | 101 | +B
204 +/A 104 +/A
CH4 205 -/B CH3 105 -/IB
206 b’ 106 b’ CH2 | 304 | /A | 204 | b | 104 | +B
207 +/A 107 +A
CH6 208 -/B CH5 108 -IB
1 1
209 b 109 b CH3 | 307 IA 207 -Ib 107 | +B
210 +/A 110 +/A
CH8 211 -/B CH7 111 -/B
212 b’ 112 b’ CH4 | 310 | /A | 210 | -b | 110 | +B
213 +/A 113 +/A
CH10 | 214 /B CHY | 114 /B Clamp terminal
215 b 115 b
o CH No. | Term.No. | Symbol Term.No. | Symbol
1 There are no symbol indications for the 201 +/B 101 Not Used
electromagnetic relay, current (mA), or low withstand CH1 202 -Ib 102 Not Used
voltage relay type. 203 /A 103 | Not Used
The RTD b terminal is connected internally. 204 | Not Used 104 | Not Used
205 +/B 105 Not Used
. . CH2 206 -/b 106 Not Used
High-speed universal 207 /A 107 | Not Used
. . 208 Not Used 108 Not Used
Terminal Diagram 209 +/B 109 | Not Used
M3 screw terminal Clamp terminal CH3 210 -/b 110 | Not Used
- 211 /A 111 Not Used
CH1 212 Not Used 112 Not Used
01201101 CH1 % 213 +/B 113 | Not Used
CH2 203 CH4 214 -/b 114 Not Used
215 /A 115 Not Used

CH3 *  Empty terminals may not be used.

307/207/107) CH3
D) (310/210/110)  CH4

CHZ\

4-wire RTD/resistance
Terminal Diagram

M3 screw terminal Clamp terminal
~&— Wiring direction ~¢— Wiring direction

mme
?
e
1\ \% Bla

b 9

WB Al 9‘

CH1

301/201/101
302

J CH6

.1 08
309/209/109

DC voltage input/DI (level) DI (contact)
& (e I

TC input

~&— Wiring direction ~&— Wiring direction
DC current input ,
(with an external shunt resistor) Wiring
QAN“\ ) CH1.CH3.CH5 CH2.CH4.CH6
e R o o
— + ¢ , 4 0
mie » | 1@ |ig ® 1@

I%);‘

* Be careful because the DI wiring is different between
level and contact.

30 IM 04L51B01-02EN



Installation and Wiring

Terminal Arrangement
M3 screw terminal

CH |Term. |Symbol [Term. |Symbol [Term. |Symbol
No. |No. No. No.
301 B 201 A 101 |
CH1 302 C 202 Not 102 C
Used
CH2 303 B 203 A 103 |
304 B 204 A 104 |
CH3 |305 C 205 Not 105 C
Used
CH4 306 B 206 A 106 |
307 B 207 A 107 |
CH5 |308 C 208 Not 108 C
Used
CHé6 |309 B 209 A 109 |
310 Not 210 Not 110 Not
Used Used Used

Clamp terminal

CH No. [Term.No. Symbol | CH No. | Term.No.| Symbol
201 | 101 |
202 A 102 A
G 203 B el 103 B
204 C 104 C

205 Not Used 105 Not Used
206 | 106 |
207 A 107 A
Gk 208 B e 108 B
209 C 109 C

210 Not Used 110 Not Used
211 | 111 |
212 A 112 A
Cnls 213 B e 113 B
214 C 114 C

215 Not Used 115 Not Used

*

Empty terminals may not be used

Wiring to a GX90XD Digital Input Module
Terminal Diagram

M3 screw terminal Clamp terminal

DI9 DI DI
DI16

DI16 DI8
COM COM COM

~¢— Wiring direction ~¢— Wiring direction

Terminal Arrangement

Term. No. |Symbol | Term. No.|Symbol
21 DI9 11 DI1
22 DI10 12 DI2
23 DI11 13 DI3
24 DI12 14 Dl4
25 DI13 15 DI5
26 DI14 16 DI6
27 DI15 17 DI7
28 DI16 18 DI8
29 COoM2 |19 COom1
30 - 20 -

Internal circuit

Input type:
Photocoupler isolation
DI1 to DI8: COM1

DI1 to DI9 to DI16: COM2

DI16 Shared common (COM)

COM1,2 Allowable input voltage range:
! 0to 10V

Note: Do not apply voltage outside the allowable input
voltage range across input terminals. Doing so can cause
a malfunction.

Wiring to a GX90YD Digital Output Module
Terminal Diagram

M3 screw terminal

~¢— Wiring direction

Terminal Arrangement

DO No. |Term. No. Symbol |DO No. |Term. No. Symbol
21 NC 11 NC

DO4 22 COM DO1 12 COM
23 NO 13 NO
24 NC 14 NC

DO5 25 COM DO2 15 COoM
26 NO 16 NO
27 NC 17 NC

DO6 28 COM DO3 18 COoM
29 NO 19 NO
30 - 20 -
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Installation and Wiring

Wiring to a GX90WD Digital Input /Output Module
Terminal Diagram

M3 screw terminal

DI
1/201/101
302/202/102
3/203/103

| (305/205/105

| oo

310/210/110

~&— Wiring direction

Terminal Arrangement

CH Term. |Symbol |Term. |Symbol |Term. Symbol
No. No. No. No.
DI1 to [301 DI3 201 DI2 101 DI1
DI8 302 DI6 202 |DI5 102 Dl4
303 DICOM |203 |DI8 103 DI7
- |304 - 204 |- 104 -
DO1 305 DO1NO |205 |DO1COM|105 DO1NC
DO2 |306 DO2NO |206 |DO2COM |106 DO2NC
DO3 307 DO3NO 207 |DO3COM 107 DO3NC
DO4 |308 DO4NO |208 |DO4COM [108 DO4NC
DO5 309 DO5SNO 209 |DO5COM 109 DO5NC
DO6 [310 DO6NO 210 |DO6COM 110 DOEBNC
Internal circuit
i Input type:
i Photocoupler isolation
i Shared common (DICOM)
Di1to U Allowable input voltage range:
DI18 0to 10V
DICOM

Note: Do not apply voltage outside the allowable input
voltage range across input terminals. Doing so can cause
a malfunction.

Wiring to a GX90XP Pulse Input Module

Terminal Diagram
M3 screw terminal

Clamp terminal

—~&— Wiring direction

~&— Wiring direction

Terminal Arrangement

Term. No.| Symbol |Term. No.| Symbol
21 CH6 + |11 CH1 |+ |
22 - 12 -
23 CH7 + 13 CH2 | + |
24 - |14 -
25 CH8 + |15 CH3 | + |
26 - |16 -
27 CH9 + |17 CH4 | + |
28 - |18 -
29 CH10 | + |19 CH5 | + |
30 - 120 -

Negative terminal (common) potential shared

Internal circuit
Input type:
Photocoupler isolation
Negative terminal (common)
potential shared
approx.5kQ Allowable input voltage:+10V

Note: Do not apply voltage outside the allowable input
voltage range across input terminals. Doing so can cause
a malfunction.

5V DC

Wiring to a GX90YA Analog Output Module

Terminal Diagram

M3 screw terminal Clamp terminal

~&— Wiring direction ~&— Wiring direction

Terminal Arrangement

Term. No. Symbol
11 CH1 +
12 -
13 CH2 +
14 -
15 CH3 +
16 -
17 CH4 +
18 -

19 Not Used

20 Not Used

32
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Installation and Wiring

Wiring to a GX90UT PID Control Module

Terminal Diagram
M3 screw terminal

301/201/101
302/202/102
303/203/103

304/204/104

305/205/105
306/206/106

209/109
2101110

~&— Wiring direction

Analog Input

DC voltage input/DI (level)

DI (contact)

® &

@ e ie

RTD input

DC current input
(with an external shunt
resistor)

*

Be careful because the DI wiring is different between
level and contact.

Analog Output

DC current output, voltage pulse, 15V DC loop power
supply

& e

\#=”

Terminal Diagram

Term. | Symbol | Term. | Symbol | Term. | Symbol
No. No. No.
301 DI3 201 DI2 101 DI1
302 Dl6 202 DI5 102 Dl4
303 DICOM 203 DI8 103 DI7

304 DO3 204 DO2 104 DO1

305 DO6 205 DO5 105 DO4

306 | DO-COM | 206 DO8 106 DO7

307 | AM(A) | 207 | AlM(-b) | 107 | Al1(+/B)
308 | AI2(UA) | 208 | Al2(-b) | 108 | Al2(+/B)
309 | NotUsed | 209 | AO1(-) | 109 | AO1(+)
310 | NotUsed | 210 | AO12-) | 110 | AO2(+)

*

Empty terminals may not be used

Internal circuit

| Input type:

E Photocoupler isolation

! Shared common (DI-COM)
DI1to Allowable input voltage range:
DI18 0to 10V

DI-COM @17

Note: Do not apply voltage outside the allowable input
voltage range across input terminals. Doing so can cause
a malfunction.

Connecting to the FAIL Output/Status Output (/
FL option)

FAIL NI A 1A

output _ NOCNC  NOCNC NOCNC
During normal  When a failure  When power is
operation occurs turned off
Status l A l\, l l A
output NOCNC NOCNC NOCNC
During normal  When the specified When power is
NO C NC operation status occurs turned off

Recommended torque for tightening the screws: 0.5N*m

Connecting to the Serial Communication
Interface (/C2 option)

RD (Received Data)
SD (Send Data)

SG (Signal Ground)
RS (Request to Send)
CS (Clear to Send)

0 (N | W IN

6 7 809

DSUB 9-pin male Pins 1, 4, 6, and 9 are not used.

Screw: M26 X 0.45

Connecting to the RS-422/485 Connector (/C3 option)
Four-wire system Two-wire syste'mm

§ G G SDB+ SDA- RDB+RDA- (P
1 ¥

N b ’ _I _I |
FG ISDB+IRDB+I FG ISDB+

SG 1SDA-|RDA- H SG nSDA—
Electric potential | | Shield  Electric potential Shield

of the shield of the shield

FG (Frame Ground)
SG (Signal Ground)
SDB+ (Send Data B+) Send data B (+)
SDA- (Send Data A-) Send data A (=)
RDB+ (Received Data B+) |Receive data B (+)
RDA- (Received Data A-) |Receive data A (=)

Case ground of the GX/GP
Signal ground

Recommended torque for tightening the screws: 0.2Nem
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Connecting to the VGA Connector (/D5 option)
5 1

D-Sub 15-pin (Female)

Pin No. |Signal Name |Specifications

1 Red 0.7 Vp-p

2 Green 0.7 Vp-p

3 Blue 0.7 Vp-p

4 —

5 —

6 GND

7 GND

8 GND

9 —

10 GND

11 —

12 —

13 Horizontal Approx. 39.1 kHz, TTL negative logic
sync signal

14 Vertical sync |Approx. 60 Hz, TTL negative logic
signal

15

A * Only connect the GX/GP to a monitor
after turning both the GX/GP and the
CAUTION monitor off.

* Do not short the VIDEO OUT con-
nector or apply external voltage to it.
Doing so may damage the GX/GP.

Connecting to a Monitor

1. Turn off the GX/GP and the monitor.

2. Connect the GX/GP and the monitor using an RGB
cable.

3. Turn on the GX/GP and the monitor. The GX/GP
screen appears on the monitor.

Nofte

When the GX/GP is turned on, the VIDEO OUT

connector constantly transmits VGA signals.

* The monitor display may flicker if you place the GX/
GP or some other device close to it.

» Depending on the type of monitor, parts of the GX/GP

display may be cut off.

Connecting to the Ethernet Port
Checking the Connection and Communication Status
You can use the indicators that are located above the

Ethernet port to check the connection status of the
Ethernet interface.

Indicators

Yellow green Orange

Connection Status of the Ethernet
Interface
Lit (yellow-green) The Ethernet link is established.

Indicator

Off (yellow-green) The Ethernet link is not established.

Blinking (yellow-green) |Receiving data

Lit (orange) Connected at 100 Mbps

Off (orange) Connected at 10 Mbps

Wiring the Power Supply
Use a power supply that meets the following conditions:

Item Condition (Not /P1) Condition (/P1)

Rated supply voltage 100 to 240 VAC 24 VDC/AC
Allowable power GX/GP: 21.6Vto 26.4
supply voltage range 90 to 132 VAC,180 VDC/AC

to 264 VAC

GX60:

90 to 132 VAC,180

to 240 VAC
Rated power supply  50/60 Hz 50/60 Hz (for AC)
frequency
Permitted power 50/60 Hz + 2% 50/60 Hz + 2%
supply (for AC)

frequency range

GX10/GP10: 48 VA GX10: 24 VA
GX20/GP20: 90 VA GX20: 48 VA
GX60: 40VA

Maximum power
consumption
100 VAC (/P1: 24 VDC)

Maximum power GX10/GP10: 60 VA GX10: 42 VA

consumption GX20/GP20: 110 VA GX20: 76 VA
240 VAC (/P1: 24 VAC) GX60: 55VA
Nofte

Do not use a supply voltage of 132 to 180 VAC, as this
may have adverse effects on the measurement accuracy.

GP10 Power Supply Suffix Code: 2

Connecting to the USB Port (/UH option)
A USB2.0 compliant port (see “Component Names”)

Item Condition

Rated supply voltage 12 VDC

Allowable power 10 V to 20 VDC

supply voltage range

Maximum power 26 VA

consumption

34
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Installation and Wiring

Precautions to Be Taken When Wiring the Power
Supply (GX10/GX20/GX60)

Make sure to follow the warnings below when wiring the
power supply. Failure to do so may cause electric shock
or damage to the instrument.

|
A * To prevent electric shock, ensure that

the power supply is turned off.
WARNING To prevent fire, use 600 V PVC in-

sulated wires (AWG20 to AWG16;
JISC3307) or wires or cables with
equivalent or better performance.

* Make sure to earth ground the protec-
tive ground terminal through mini-
mum resistance before you turn on
the power.

* Use crimp-on lugs (designed for 4
mm screws) with insulation sleeves to
connect both the power cord and the
protective ground.

* To prevent electric shock, be sure to
close the transparent cover for the
power supply wires.

* Provide a power switch (double-pole
type) on the power supply line to
separate the GX/GP from the main
power supply. Use labels to indicate
that this switch is for cutting off the
power supply to the GX/GP and to
indicate ON and OFF.

Switch specifications

Steady-state 1 A or higher (Not /P1),
current rating 3 A or higher (/P1)
Inrush 60 A or higher (Not /P1),
current rating 70 A or higher (/P1)

Must comply with IEC60947-1 and
IEC60947-3.

¢ Do not add a switch or fuse to the
ground line.
|

Wiring Procedure (GX10/GX20/GX60)

1. Turn off the GX power supply, and then remove the
transparent power supply terminal cover.

2. Connect the power cord and the protective ground cord
to the power supply terminal. Use ring-tongue crimp-
on lugs (for M4 screws) with insulation sleeves. The
appropriate tightening torque for the screws is 1.4 to
1.5 Nem.

Protective ground

3. Attach the transparent power supply terminal cover,
and fasten it with screws.

Precautions to Be Taken When Connecting the
Power Supply (GP10/GP20/GX60)

Make sure to follow the warnings below when connecting
the power supply. Failure to do so may cause electric
shock or damage to the instrument.

|
A * Before connecting the power cord,

ensure that the source voltage

WARNING matches the rated supply voltage of
the instrument and that it is within the
maximum rated voltage range of the
provided power cord.

¢ Connect the power cord after check-
ing that the power switch of the in-
strument is turned OFF.

¢ To prevent electric shock and fire, be
sure to use a power cord purchased
from Yokogawa Electric Corporation.

¢ Make sure to connect protective earth
grounding to prevent electric shock.
Insert the power cord into a grounded
three-prong outlet.

* Do not use an extension cord without
protective earth ground. If you do, the

instrument will not be grounded.
|

Connection Procedure

1. Check that the GP’s power switch is off.

2. Connect the supplied power cord plug to the power
inlet on the rear panel of the GP or front panel of the
GX60.

3. Ensure that the source voltage is within the maximum
rated voltage range of the provided power cord. Then,
connect the other end of the cord to the outlet. Use a
grounded three-prong outlet.
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Precautions to Be Taken When Connecting the
Power Supply (GP10 Power supply Suffix Code: 2)
Make sure to follow the warnings below when connecting
the power supply. Failure to do so may cause damage to
the instrument.

A * Wire the power cable to the power
supply terminal, making sure that the
WARNING polarity is correct.

e Connect the power cables after
checking that the power switch of the
instrument is turned OFF.

* Using other wires may cause abnor-

mal heating or fire.
I

Wiring Procedure (GP10 Power supply Suffix Code: 2)

1. Turn off the GP power supply, and then remove the
transparent power supply terminal cover.

2. Wire the power cable to the power supply terminal,
making sure that the polarity is correct.
Use ring-tongue crimp-on lugs (for M4 screws) with
insulation sleeves. The appropriate tightening torque
for the screws is 1.4 to 1.5 Nem.
Use 600 V PVC insulated wires (AWG20 to AWG16;
JISC3307) or wires or cables with equivalent or better
performance.

() )

3. Attach the transparent power supply terminal cover,
and fasten it with screws.

36
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This section explains the details indicated as “Basic Operation” in the operating procedure on pages 20 and 21.

Basic Operation

GX60
Turn on the power switch.

ITurning the Power On and Off

A

WARNING

To make panel door lock for GX10/GX20
or install the GP/GX60 systems in a
panel with a door or in a location where
operator or any third person can not
operate the power switch carelessly.
When the power switch of GX/GP
systems under operation (control in
progress) be turned on or off carelessly
, it may result the system down or injury.
Be careful to operate the power switch
on or off.

Careless operations can be avoided by
applying the slide lock.

Turning the Power On
|
A Check the following points before
turning on the power switch.
CAUTION -+ The power cord or wires are connect-
ed properly to the GX/GP and GX60.
* The GX/GP is connected to the correct
power supply.
If the input wiring is connected in
parallel with another instrument, do not
turn on or off the GX/GP/GX60 or other
instrument during operation. If you do,
measured values may be affected.
|

GX/GP
1 Open the front door.

2 Turn on the power switch.
A self-test takes place for a few seconds, and then
the operation screen appears.

YOKOGAWA 4

2012/09/12 09:30:06

‘ onec/m

Power switch

3 Close the front door.

If nothing appears on the display even
when you turn on the power switch,
turn off the power switch, and check
the wiring and supply voltage. If, after
checking these items, the GX/GP still
fails to start when you turn on the
power switch, it may be malfunction-
ing. Contact your nearest Yokogawa
dealer for repairs.

If an error message appears on the
screen, take measures according to
the information in chapter 5, “Trouble-
shooting” in the GX/GP User’s Manu-
al.

e After you turn on the power switch, al-
low the GX/GP to warm up for at least
30 minutes before starting a measure-
ment.

A .

CAUTION

Turning the Power Off
A Check the following points before
turning off the power switch.

CAUTION - The external storage medium is not
being accessed (the yellow-green LED
is not blinking).

GX/GP

1 Open the front door.

2 Turn off the power switch.
3 Close the front door.

GX60
Turn off the power switch.
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Basic Operation

Setting and Removing SD Memory IViewing the Operation Screen (Trend)
Cards
. Status display section
Setting a SD Memory Card Shows the display name, date/time,
1 Open the front door. data recording, alarm icons, etc.
2 Insertan SD memory card into the card slot. Numeric display section —
GROUP_1 2012/12/12 08:52:30 _ &apISP 57min| s\
mogango || L
- = T e
T gz [Channel003 —16005’
Ll ? -1
gy @ [Channel 005 _13295’
N S
7 =T oose
o / A ; iﬁ s
. <= S [T . 7870
Removing the SD Memory Card Tl e
N $ | e
1 Press MENU. — o o ,-\2 ’% -0.5145
00 =00 |omsag00 [0m: 00 |ogeage0n o0 [ogest00 [om:sd:o0 [oeesifen e -0.3789
2 Tap the media eject icon. "
R Waveform I_ Scal
R - & 3. — di cale
Q £B0 Rec:ﬁng ComEtinQ ‘0~ dISpIay
Data display section
[« <] 1 D] Shows measured data and function
g/: l m setup screens
Context Trend B ovenvew sy
B i
) Status Display Section
Universal Q % ﬂ p y
ot sating seve losd || Calration fRoup 1 ———2012/12/12 10:45:50 |82 For o Rl A )
E‘.Il I
Browse Date and time
i 2 m I Pk E, Recording status icon Control status icon
oo s M ovome: B owomes B owowes | i Recording in progress &3 g% ';,‘ISL ;n % %
3 On the screen for selecting the type of media, tap Recording stopped gl gt%?;t;gld LA
SD. Data type
4 Remove the SD memory card. DISP: Display data
. EVENT: Event data
Operation complete I
Recording progress

Displays the progress using a green bar graph.
The frame indicates the saving interval (display
data) or data length (event data).

PISP X Internal memory error

— Display name or group name

—~When using the batch function
arour 1 '2012/12/12 10:14:07

When using the login function
e 2012/12/12 10:17:54

When using the login and batch functions

12712 10:18:44
ROUP 1

Ba
User Nane012345678901
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Basic Operation

lerouP 1 2012/12/12 10:45:50 e T A 1)

SD memory card icon
Remaining memory space 50% or more
Ia Remaining memory space 50% or less
Remaining memory space 10% or less

B External medium error

Math icon (/MT option)
Gray icon: Computation started

@ Yellow icon: Computation data dropout occurred

Status icon

The condition assigned to instrument information
output is occurring.

([.hh Operation lock is enabled.
[»<] E-mail transmission is enabled.

Alarm icon

m Displayed when any alarm is activated.

Lit in red Alarm activated.

Blinking in red  Alarm indication set to hold. Alarms are
currently activated, and some alarms have not
been acknowledged.

Blinking in gray Alarm indication set to hold. All alarms have
been cleared after alarms have occurred, but
some alarms have not been acknowledged.

IDispIaying the Menu Screen

To change the display between various setup screens and
operation screens, display the menu screen.

7 Press MENU.
The menu screen appears.

MENU key
Tabs ‘ rRecording icon Icons
2pj s Q

GROUP 1

=

Buzzer Snap Manal

a

Login

> d d =]
e sue swe
iy ey ] P

AR
B 2 i

Change
©__Unlock password

* | @ | =

Remove Standard
display Message

Scrolls the menu in the tab
(These appear when the number of icons exceeds
the maximum number that can be displayed.)

ISetting the Date and Time*

* If you need to set the time zone or DST (Daylight Saving

Time) or both, do so before setting the date and time.

m MENU key > Browse tab > Setting > Setting
menu > System settings > Time basic
settings

Set the date using the calendar and the time.
m MENU key > Universal tab > Date/Time
settings

1 Tap the Date tab.
2 Set the month and day with the switch icons.

Date tab Switches the year Switches the month

Date
2012/12/12 2011
T sun
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Basic Operation

3 Tap the Time tab.

4 Enter the time using the keyboard, and tap OK.
The time is set.

Operation complete I

IConfiguring the Inputs
For channel 1 (0001) of slot 0, set thermocouple type T, 0
to 200°C.

m MENU key > Browse tab > Setting >
Setting menu > Al channel settings > Range

[FAVORITE 4 2012/12/16 11:05:32 i PISP ]
<« Range (0001 - 0001)
. First-CH
m AT channel settings 0001 1
. Last-CH
B 01 channel settings 0001 2
Math channel settings R""QET
ype
— s e 3
/\/ Display settings 2
/ ange
el settings s . T 4
pan Lower
b i i s 0.0 °C 5
ws Recording settings -
Span Upper 6
: 4 200.0 °C
I, Data save settings -
Calculation
|, Batch settings off
Moving average
Report settings ‘ on/off
| off
e o7

Tap First-CH > 0001.

Check that Last-CH is 0001.

Tap Type > TC.

Tap Range > T.

Tap Span Lower, and enter 0.0.
Tap Span Upper, and enter 200.0.

NOGORAWN

Tap Save.

Operation complete I

IStarting Measurement and Recording

7 Press MENU.
The menu screen appears.

Context

isplay
ata Group.
on_|[OAll’ channel

Universal

Browse

f 2 3 4 g
o I *%
o s B o B owes B rwomes B e

Tap the Recording icon.
The record start screen appears.

3 Tap Record.
Recording starts. The recording status icon in the
status display section changes to recording in prog-
ress.

Operation complete I

You can also start recording with the START/
STOP key.

You can stop recording in the same way that you
start recording.

ISwitching between Operation Screens

7 Press MENU.
The menu screen appears.

Digital —

Trend —I

Bar graph
— Overview

-

ecording Computir|

vervi

eeeee

EE

i

.

iz

9

2 3 4 5
\ AT = *m
.
h ez B ewomes B ewomee B it

2 Tap the Browse tab.

3 Tap the icon of the display that you want to change
to.

Operation complete I
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Basic Operation

ISaving Data to USB Memory

1 Set the USB memory.
The Media operation screen appears.

Tap the Memory save Data save icon.
The Memory summary / Save screen appears.

2
3 Press MENU.
4

The menu screen appears.

Tap the Context tab.
Each data save icon appears.

—— Data save icon

Recording|

Memory summjary/Save

&: =] =] =]

e
Context

2

Universal

E‘.Il

Browse

Tap data save icon to save.
The data save screen appears.

6 Select the USB, and tap OK.
The data is save to USB memory.

Operation complete I

ISwitching the Quick Settings (GP
only)

A minimal setup menu for data collection is displayed.
FZZ™ MENU key > Browse tab > Setting >

Setting 2016/02/04 11:13:32  wifber———
Standard setting ‘ Quick setting —.— 1
Al channel settings
m AL channel settings Range 14
m DI channel settings Alarm 14
[ 00 channel settings Display settings »
Math channel settings Calibration correction »
/\/ Display settings
&/ Measurement settings

é Recording settings

I, Data save settings

ln n..

[=> Exit =

1 Tap the Quick setting tab.
Setting menu of the quick setting is displayed.

Operation complete I
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This section explains how to change various settings.
Before you change settings, stop recording and computation.

Advanced Operation (Various settings and operation)

Setting Measurement and Recording Setting the Trend Interval
Conditions 2™ MENU key > Browse tab > Setting >
Setting menu > Display settings > Trend
Configuring the type of data to record to display data, the inte:'vgal . 1splay N9
scan interval to 2 s, and the trend interval to 1 min.
FAVORITE 4 2012/12/16 11:12:29 wmplsP |

Setting the Type of Data to Record | -

m MENU key > Browse tab > Setting > B A channel settings Trend interval [/div
Setting menu > Recording Settings >
Basic settings

e — 1

Off

. Trend rate switching
m DI channel settings

Math channel settings

FAVORITE 4 2012/12/16 11:10:39 i PIsP "\ Display settings
B eetiiies @ Measurement settings
m AT channel settings I Rewr:‘tzg;‘:de + 1 é Recording settings
B ot chamel setinas | Display data, Trend waveform e &, Date save settings
Math channel settings ‘ Saving interval ‘ [, Batch settings
| 10min
/\/ Display settings Report settings
2] Measurement settings
__E’ Exit -E Save —2
é Recording settings
I, Data save settings
1, Batch settings 1 Tap Trend interval [/div] > 1 min.
Report settings 2 Tap Save.
= Exit d — .
2 Operation complete |
7 Tap File type > Display. ISettlng Alarms
2 Tap Save. On channel 1 of slot 0, set the high limit alarm at the alarm
value of 150°C.

You can set the file type to record only the data that
suits your purpose. For example, you can record
detailed data or record data only when alarms occur.

m MENU key > Browse tab > Setting >
Setting menu > Al channel settings > Alarm

For details, see the User’s Manual (lM 04L51B01- FAVORITE 4 2012/12/16 11:13:37 appIsP ]
01 EN) E Alarm (0001 - 0001)
) First-CH
m AT channel settings o001 1T 1
Setting the Scan Interval Bl o1 chamet settings e woor T2
) = ) Level 1
™ MENU key > Browse tab > Setting > B wath chame settings , owor 4l 5
Setting menu > Measurement settings > "\ Display settings e on
Scan intel"val Measurement settings H : High limit _-_4
o Value
é Recording settings 7 150.0 °C _-_5
FAVORITE 4 2012/12/16 11:11:47 s pIsP ] Hysteresis
Measurement settings I, Data save settings Coaame 0.5 %
m AI channel settings ‘;ca" S‘:::W‘:L(EWEL +_ 1 [\, Batch settings ouput e on
B ot chomel settings ‘ ’ 2 Report settings — off
ver-range eve
Math channel settings ! Value on over-range over ‘ IE__ 6
/\/ Display settings Module settings
@] Measurement settings ‘ Select module » ‘ 1
é Recording settings Tap FIrSt-CH > 0001 .
L Dota save settings 2 Check that Last-CH is 0001.
\ﬁ Batch settings
3 Tap Level1 > On.
Report settings 4
>
a2 Tap Type > H.
5 Tap Value, and enter 150.0.
1 Tap Scan interval > 2s. 6 Tap Save.
2 Tap Save. Operation complete |

Operation complete I
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Advanced Operation (Various settings and operation)

IAIarm DO output

Alarms are transmitted via DO output to DO channel 1 of
slot 1. (A DO output module is required.)
Configure the following settings in the alarm settings (see

« . »
Setting Alarms”).
otine 2015/09/24 08:57:32
<« Alarm (0001 - 0001)
m AI channel settings 0001
Last-CH
m DI channel settings 0001
Level 1
m DO channel settings On/Off
on
Wl Math channel settings Type
H : High limit
N\ Display settings Value
150.0 °C
&/ Measurement settings Hysteresis
05 °C
é Recording settings Logging
on
[, Data save settings Output type 1
Relay
|, Batch settings Output No.
0101 2

1 Tap Output type > Relay.

2 Tap the Output No., and enter 0101.

Using the Scaling Function
(Measuring a flow meter)

On channel 1 of slot 1 (0101), measure the input signal
ranging from 1 to 5 VDC as 0.0 to 100.0 m%h.

lm MENU key > Browse tab > Setting >
Setting menu > Al channel settings > Range

FAVORITE 4 2012/12/16 11:14:40 i PISP |
<« Range (0101 - 0101)
. First-CH
m AI channel settings 0101 1
. Last-CH
m DI channel settings 0101 2
Math channel settings R""QET
ype
: ) ’ o 3
/\/ Display settings 2
ange
£/ Measurement settings 1-5v 4
Span Lower
&% Recording settings 1.0000 v
Span Upper
E& Data save settings 5.0000 V
Calculation 5
|, Batch settings Linear scaling
Scale
Report settings ‘ Decimal place \ ‘
I z T B

4

2™ MENU key > Browse tab > Setting >
Setting menu > DO channel settings > Range

fr) 2015/09/24 08:58:11 it
<« Range (0101 - 0101)
m Al ch | setti First-CH
channel settings 0101 1
m bl ch | setti Last-CH
channel settings 0101
[ oo channel settings R
Type 3
Math channel settings Alarm
Span Lower
N\ Display settings 0
Span Upper
&/ Measurement settings 1
Unit
é Recording settings
Action
I, Data save settings Energize/De-energize
Energize
|, Batch settings Action
or
1
B> Exit [=] __4

Tap First-CH > 0101.
Check that Last-CH is 0101.
Tap Range Type > Alarm.

AW

Tap Save.

Operation complete I

SO A WN

© C N

FAVORITE 4 2012/12/16 11:15:52 s PISP |
& Range (0101 - 0101)
X Calculation
m AI channel settings Linear scaling
Scal
m DI channel settings @ EDEUmaL place
| . 7
Math channel settings
Scale Lower
/\/ Display settings 0.0 m3/h 8
7 Scale Upper
£/ Measurement settings it 100.0 m3/h 9
Id
é Recording settings m3/h 10
Low-cut
I, Data save settings ‘ On/0ff
L Off
|, Batch settings Moving average
[ on/off
Report settings ‘ off
Burnout set

B —11

Tap First-CH > 0101.

Check that Last-CH is 0101.

Tap Type > GS.

Tap Range > 1-5V.

Tap Calculation > Linear scaling.

Drag the screen up.

Show the setting parameters off the screen at the
bottom.

Tap Decimal place > 1.
Tap Scale Lower, and enter 0.0.

Tap Scale Upper, and enter 100.0.

10 Tap Unit, and enter m3/h.
11 Tap Save.

Operation complete I
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Advanced Operation (Various settings and operation)

IUsing the Scaling Function
(Measuring a temperature)

On channel 1 of slot 0 (0001), measure the input signal
ranging from 0 to 5 VDC as 0.0 to 600.0 °C.

m MENU key > Browse tab > Setting >
Setting menu > Al channel settings > Range
[Setting 2016/06/09 14:17:01 e ——

<« Range (0001 - 0001)
) First-CH
m AL channel settings

Last-CH
m DI channel settings

m Pulse input channel Range
L settings

0001

0001

Type

m DO channel settings Volt
Range

Math channel settings v
Span Lower
N\ Display settings

&/ Measurement settings

# Recording settings

0.000 V

Span Upper

5.000 Vv

Calculation

Linear scaling
Scale

[, Data save settings ‘ Decimal place
|
[=> Exit

Q® NOOURAW N

Setting 2016/06/09 14:17:26  wmilhar————

<« Range (0001 - 0001)

5000V |
m Al channel settings

m DI channel settings SR

m Pulse input channel Decimal place

9
Scale Lower
[ 00 channel settings 0.0 10

++
il Math channel settings 6000 —TT— 1 1

N\ Display settings ot 12

Calculation

Linear scaling

Scale Upper

Moving average
On/0ff

&/ Measurement settings

# Recording settings

Off

I, Data save settings

[=> Exit

Value

[

\
Bias

|

0.0

Tap First-CH > 0001.

Check that Last-CH is 0001.

Tap Type > Volt.

Tap Range > 6V.

Tap Span Lower, and enter 0.000.
Tap Span Upper, and enter 5.000.

Tap Calculation > Linear scaling.

QNI OGANGWN

Drag the screen up.

Show the setting parameters off the screen at the
bottom.

9 Tap Decimal place > 1.

10 Tap Scale Lower, and enter 0.0.
11 Tap Scale Upper, and enter 600.0.
12 Tap Unit >, and enter °C.

13 Tap Save.

Operation complete I

IRegistering and Deleting Favorite
Screens
You can register displays that you use frequently as

favorite screens and display them with easy operation.
You can register up to 20 displays.

Registering a Favorite Screen

1 Show the display that you want to register as a
favorite screen.
2 Press MENU.
The menu screen appears.
Close button—l

Recording

GROUP 1

m)
o]
Al dota
dsplay
&=
B
r4%%)
Display
960w
ion ||l Charnel

Browse

Scroll

Tap Add favorite.
A confirmation screen appears.

Tap Favorite name, and enter the name.

Tap OK.
The display is registered.

A A W

Tap the Close icon.
The screen closes.

Operation complete I

Deleting a Favorite Screen
Press MENU.
Tap Universal tab > Remove favorite.

Select the screen to delete, and tap OK.

AWN

Tap the Close icon.
The screen closes.

Operation complete I
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This section explains the measurement mode, which needs to be set properly according to the measurement conditions.

Setting the Measurement Mode

ISetting the Measurement Mode

The measurement mode determines how the entire
GX/GP system operates. The GX/GP measurement
characteristics change depending on the measurement
mode. The measurement mode must be set before
reconfiguration and before specifying various settings.

By factory default, the measurement mode is set to
Normal. When performing high-speed or dual interval
measurement according to measurement conditions, you
need to set the measurement mode to High speed or Dual
interval.

Press MENU.

Tap the Browse tab.

Tap Initialize Calibration.

Tap Measuremet mode.
Setting the Measurement Mode.

Tap Execute.
A confirmation screen is displayed.

Tap OK

N OOAhAGWNh

Operation complete |

Nofte

*  When the measurement mode is changed, the system
restarts, and the following data is initialized. Set the
measurement mode before reconfiguration and before
specifying various settings.

Data subject to initialization

All internal data

All setting parameters including security settings but

excluding communication settings

System configuration data

* You cannot set the measurement mode when
recording, computation, or control execution is in
progress.

* The measurement mode is not initialized during
initialization.

» If the advanced security function (/AS) or multi-batch
function (/BT) is enabled (On), the measurement
mode is fixed to Normal.

When changing the measurement mode, disable the
functions beforehand.

ILimitations

Depending on the measurement mode, there is a limit

to the number of measurement channels, the number of

recording channels, and the supported modules.

For the specific limitations, see the limitations provided in

the following general specifications.

* GX/10/GX20 Paperless Recorder (panel mount type)
General Specifications GS 04L51B01-01EN

* GP10/GP20 Paperless Recorder (portable type)
General Specifications GS 04L52B01-01EN
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This section explains what you need to do when you change the module configuration (by installing or removing modules).

Reconfiguring the GX/GP (Module identification)

IReconfiguring the GX/GP

When you reconfigure the GX/GP and the GX60, the

installed 1/0 modules are detected, and the settings are

changed accordingly.

Reconfiguration is necessary in the following situations.

 If you specify modules separately

 If you change the modules (change to different modules)

» If you add or remove modules

» If you connect the GX60

*  When the measurement mode is changed

* When the advanced security function on/off state is
changed

If you purchased a model with preinstalled modules (/U[]

[10 or /CR{][] option), you can start using the GX/GP right

away without any reconfiguration. However, if you connect

the GX60, change modules, add modules, or delete

modules, you will need to reconfigure.

Nofte

You cannot reconfigure GX/GP while recording start
,math start, controled.

Press MENU.
Tap the Browse tab.
Tap Initialize Calibration.

Tap Reconfiguration.

A WN

Tap Execute.
The system information appears.
System i i 2017/03/01 08:16:20 wAPISP ]

System information

Channel information Internal memory capacity

Input | Output | Math | Communication 500 MB

60Ch | 22Ch | 100Ch 300Ch
Optional information
EtherNet/IP communication WT communication
Mathematical function(with report function) Communication channel function
Advanced security function Custom display function
Log scale USB _interface(Host 2 ports)

OPC-UA server

Aerospace heat treatment
Program control

MAC address
XX-XX-XX-XX-XX-XX
Version information

SLMP communication
Multi-batch function

Serial number
XXXXXXXXX
Web app version information

RX.XX. XX RX.XX.XX
Measurment mode Advanced security function
Normal off
v - 0 !
= —_—
o | B reconon—— 6

6 Tap Reconfigure.
7/ TapOK.

Operation complete I

Nofte

Do not carry out the following operations while the GX/
GP is reconfiguring.

* Turn the power off and on

* Insert or remove modules

This procedure is not necessary if you purchased an 1/0
module preinstalled model and do not need to change the
configuration.

Initializing the GX/GP

(Initializing all settings)
Initialize the GX/GP after reconfiguring the GX/GP when
channels are not assigned to display groups. Channels

are automatically assigned during initialization.
For details, see the User’s Manual (IM 04L51B01-01EN).

Nofte

» This procedure is not necessary if you purchased an
1/0 module preinstalled model and do not need to
change the configuration.

» If you initialize, setting parameters are reset to their
factory defaults. We recommend that you back up
setting parameters before initialization.

Press MENU.
Tap the Browse tab.

Tap Initialize Calibration > Initialize > Settings/
Inter data.

A QWON=

Tap Initialize all > On.

Init/Calib 2017/03/02 17:53:47 SADISP
&« Settings/Internal data
Initialize all !
Initiali —_—
O mitialize o 4

E‘% Reconfiguration

P Beate —_—
(" Touch screen calibration J

[} a/o calibration
Eyrop——
B traptioncanticoe |

[ Multi batch
C' update

[=> Exit

5 Tap Execute.
A confirmation screen is displayed.

6 Tap OK.
The settings are initialized.

Operation complete I
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This section explains how to back up setting parameters.

Before you change the module configuration or settings, we recommend that you back up the setting parameters.

Saving and Loading

Setting Parameters

ISaving Setting Parameters

Save setting parameters to the SD memory card with the
file name “SF1.”

m MENU key > Browse tab > Save load
> Menu Save settings > Setting parameters

Save load 2012/12/16 11:18:27  wPISP |
&« Setting parameters
N i Media kind
[l Load display data P 1
4~ File name
4 Load event data 1 -._2
C t
E}, Load settings ommen
[, Save settings ‘
1
B File list ‘ 3
B Format
= Exit 4

Tap Media kind > SD.

Tap File name, and enter SF1.
Tap Execute.

Tap Exit.

N WN

Operation complete I

ILoading Setup Parameters

Load the setup parameter file “SF1.GNL” from the SD
memory card.

m MENU key > Browse tab > Save load
> Menu Load settings > Setting parameters

Save load 2012/12/16 11:20:18 i PISP
&« Setting parameters

M i Media kind 1

[l Load display data o — 1
N Select file

[ Load event data SFLGNL --—2
ﬂ Load settings

[ AlL settings ‘

[, Save settings ‘ On
B File st ‘ Erecute +_3
B Format

= Exit 4

Tap Media kind > SD.

Tap File name > SF1.GNL.
Tap Execute.

Tap Exit.

NWN

Operation complete I
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Web Application

You can open the Web application simply by starting a Web browser (IE11), and specifying

the GX/GP IP address. You do not have to install any software. You can do the following on
the Web application.

» Operate the GX/GP

* Monitor data

» Changing setting parameters

For details on configuring the environment settings to connect the GX/GP to an Ethernet
network and how to use the software, see the User’s Manual (IM 04L51B01-01EN).

Starting the Web Application
1 Start the Web browser.

2 In the Address box, enter “http://” followed by the GX/GP IP address.
If DNS is available, you can specify the host name in place of the IP address.
Example: When the IP address is “192.168.1.1,” enter
http://192.168.1.1
in the Address box.

The Web application starts, and the screen appears.
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Type: Tread Gr:z[GROUP 2 = - Type: Trend Gr:[ GROUP 4 =]
1D uwv@ e B @rr 4 MWauwB ac Bae @rr 4

1325
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Operation complete

Closing the Web Application

When close the Web browser, the Web application also closes.
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Application Software

The following software applications are available for the

GX/GP.

+ SMARTDAC+ STANDARD Universal Viewer

« SMARTDAC+ STANDARD Hardware Configurator
(Included program pattern setting)

You can use SMARTDAC+ STANDARD Universal Viewer

to display on screen and print the following types of data

that is generated by recorders.

« Display data files

» Event data files

* Report data files (including hourly, daily, monthly, batch,
and daily-custom, and free reports)

* Manual sampled data files

Two different recording data files can be displayed
superimposed.

You can attach also convert measured data to ASCI| or

Excel formats.

You can use SMARTDAC+ STANDARD Hardware

Configurator to create and edit setup data for the GX/GP

recorder.

In addition, program patterns can be created and sent to

the GX/GP.

You can download the latest software and labels from the
following URL.
URL: www.smartdacplus.com/software/en/
You can the labels on the front door of the GX/GP.
Enter or print tag names on them for use. You can use
Microsoft Office Excel 2003 or later to edit the labels.
You can download the product user’s manuals from the
following URL.
URL: www.smartdacplus.com/manual/en/

IPC System Requirements

0os
(O8] Type
Windows 7 Home Premium SP1 (32- or 64-bit edition)
Professional SP1 (32- or 64-bit edition)
Windows 8.1 |Update
Pro Update
Windows 10  |Home (32- or 64-bit edition)
Pro (32- or 64-bit edition)

CPU and main memory

oS CPU and main memory

Windows 7 32-bit edition: Intel Pentium 4, 3 GHz or faster
Windows 8.1 |x64 or x86 processor. At least 2 GB of memory.
Windows 10  |64-bit edition: Intel Pentium 4, 3 GHz or faster
x64 processor. At least 2 GB of memory.

Web Browser

Compatible Browser Version
Windows Internet Explorer |Explorer 11
Java Runtime Environment
1.8.0_xx (Version 8 Update
xX) XX is 121 or more

Hard disk

Free space of at least 100 MB (depending on the amount
of data, you may need more memory).

Display

A video card that is recommended for the OS and a
display that is supported by the OS, has a resolution of
1024%768 or higher, and that can show 65,536 colors (16-
bit, high color) or more.

Other Operating Conditions

To view the user’s manuals, you need to use Adobe

Reader 7 or later by Adobe Systems (the latest version
recommended).

Ilnstallation

To install Universal Viewer or Hardware Configurator,
download the installer from the Yokogawa website.

1 Turn on the PC, and start Windows.
Log onto Windows as an administrator.

2 Double click the installer (**.exe).
The installer starts. Follow the instructions on the
screen to install the software.

Note

» Close all other software applications before installing
this software.

« To reinstall the software, uninstall the current software
first.

Hardware Configurator

* The “Countries/regions except Japan” selection dialog
box appears during installation. Select the country that
you will use the software in.

e The HTTP port for using the Web browser is set
to 34443. If this port is already in use by another
application, you will not be able to start Hardware
Configurator even if you install it. In such a case,
perform the corrective action on section 1.4 in
SMARTDAC+ STANDARD Hardware Configurator
User’s Manual (IM 04L61B01-02EN).
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Using the Application Software

About the User’s Manuals

The user’s manual is installed with the software. To view
the manual, on the Help menu, click Instruction Manual.
You can also access it from Start > All Programs.

Use Adobe Reader 7.0 or later to view the manual.

The software and manual are installed for the following
languages.

Universal Viewer

Language Software User’s manual
Japanese Japanese Japanese
English English English
Chinese Chinese Chinese
French French English
German German
Russian Russian
Korean Korean
Hardware Configurator
Country Selected at Software User’s manual
Installation
Japanese Display language |Japanese,
Regions except Japan |selectable: English, Chinese
Japanese/English/
German/French/
Russian/Chinese/
Korean

IStarting and Closing Universal Viewer
Starting Universal Viewer

1 From the Start menu, click All Programs -

SMARTDAC+ STANDARD - Viewer.
Universal Viewer starts.

Closing Universal Viewer
7 on the File menu, click Exit. O, click the x button.

Specifying a File Name and Opening the Data
File
1 On the File menu, click Open. Or, click Open on the

toolbar.
The Open dialog box appears.

2 Select the data file you want to open, and click

Open. Or, double-click the file.
The data appears in the window.

IStarting and Closing Hardware
Configurator

Starting Hardware Configurator

1 From the Start menu, select All Programs
- SMARTDAC+ STANDARD - Hardware

Configurator.

The first time Hardware Configurator starts after
installation, the Windows Security Alert dialog box
appears. Click Unblock.

Hardware Configurator starts, and the following
window appears.

laTeTololo fo ool

) e e e e e f e
2|88 =[] |=[=8]8]=

) f e e e e e f e

Nofte

» Hardware Configurator will not start if Internet Explorer
is not installed.

» The default settings are the system configuration of
the GX10.

Closing Hardware Configurator

Close Internet Explorer.

1 Click the Close button; or on the File menu, click
Exit.

Nofte

If you change the setup data, the changes are stored and
will appear the next time you start the software.
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Setup Menu Map

Depending on setting parameter values, some items may be hidden. For details, see the User’'s Manual (IM 04L51B01-01EN).

|AI channel settings, Al (mA) channel settings

\Range

First-CH

Last-CH

Range

Type

Range

Span Lower

Span Upper

Calculation

Reference channel

Scale

Decimal place

Scale Lower

Scale Upper

Unit

Low-cut

On/Off

Low-cut value

Low-cut output

Moving average

On/Off

Count

First-oder lag filter 2 ®

On/Off

Filter coefficient

RJC'3

Mode

Temperature

Burnout set 3

\Mode

Bias

\Value

\Alarm

First-CH

Last-CH

\Display settings

First-CH

Last-CH

Tag

\Characters

\No.

Color

\Color

Zone

Lower

Upper

Scale

Position

Division

Bar graph

Base position

Division

Partial

On/Off

Expand

Boundary

Color scale band

Band area

Color

Display position Lower

Display position Upper

Alarm point mark

Indicate on Scale

Mark kind

Alarm 1 color

Alarm 2 color

Alarm 3 color

Alarm 4 color

Display characters of
each value

0

1

Level 1

On/Off

Type

Value

Hysteresis

Logging

Output type

Output No.

Level 2

[on/off

Level 3

[on/off

Level 4

[on/off

Alarm delay

Hour

Minute

Second

‘Calibration correction

First-CH

Last-CH

Mode

Mode

Number of set points

1

\ Linearizer input

\Linearizer output

Execution of input

measurement

12

\ Linearizer input

\Linearizer output

Execution of input
measurement

IM 04L51B01-02EN
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Setup Menu Map

Setting when the mode is set to Correction Coefficient on

a module with an /AH option

1

Uncorrected value

Instrument correction
factor

Sensor correction
factor

Execution of input
measurement

12

Uncorrected value

Instrument correction
factor

Sensor correction
factor

Execution of input
measurement

1 Not displayed for Al (mA) channel setting.
2 Appears for channels of high-speed Al modules
3 Not displayed for 4-wire RTD/resistance type.

|DI channel

*

settings |

\Range

First-CH

Last-CH

Range

Type

Span Lower

Span Upper
Calculation
Reference channel
Scale

Decimal place
Scale Lower
Scale Upper

Unit

\Alarm

First-CH
Last-CH
Level 1
On/Off
Type

Value
Hysteresis
Logging
Output type
Output No.
Level 2
[on/off |
Level 3

[on/Off \
Level 4

[on/off |
Alarm delay
Hour
Minute
Second

\Display settings

First-CH |
Last-CH |
Tag
Characters
No.

Color
‘Color
Zone
Lower
Upper
Scale
Position
Division*
Bar graph
\Base position \
\Division* \
Alarm point mark
Indicate on Scale
Mark kind

Alarm 1 color

Alarm 2 color

Alarm 3 color

Alarm 4 color
Display characters of
each value

0
1

When the range type is set to Pulse.
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Setup Menu Map

|Pulse input channel settings

\Range

First-CH

Last-CH

Range

Type

Range

Chatterring filter

Span Lower

Span Upper

Calculation

Reference channel

Scale

Decimal place

Scale Lower

Scale Upper

Unit

Moving average

[on/off

\Count

\Alarm

First-CH

Last-CH

Level 1

On/Off

Type

Value

Hysteresis

Logging

Output type

Output No.

Level 2

[on/off

Level 3

[on/off

Level 4

[on/off

Alarm delay

Hour

Minute

Second

\Display settings

First-CH

Last-CH

Tag

Characters

No.

Color

\Color

Zone

Lower

Upper

Scale

Position

Division

Bar graph

Base position

Division

Color scale band

Band area

Color

Display position Lower

Display position Upper

Alarm point mark

Indicate on Scale

Mark kind

Alarm 1 color

Alarm 2 color

Alarm 3 color

Alarm 4 color

|AO channel settings

\Range

First-CH

Last-CH

Range

Type

Range

Span Lower

Span Upper
Reference channel
Channel type
Channel no

Preset value

\ Preset value
Preset action

At power on

On error

During stop conditions

\Display settings

|DO channel settings |

First-CH |
Last-CH \
Tag
Characters
No.

Color
\Color
Zone
Lower
Upper
Scale
\Position \
[Division |
Bar graph
Base position
Division

\Range

First-CH |
Last-CH |
Range

Type

Span Lower

Span Upper

Unit

Action
Energize/De-energize
Action

Hold

Relay Action on ACK
Relay deactivated
interval

\Display settings

First-CH
Last-CH
Tag
Characters
No.

Color
\Color
Zone
Lower
Upper
Scale
\Position \
Bar graph

\Base position \
Display characters of
each value

0
1
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|Math channel settings |

\Calculation expression

First-CH

Last-CH

Math range

On/Off

Calculation expression

\Constant

Number of constant

Constant
K001

K100

Decimal place

Span Lower

Span Upper

Unit

TLOG

Timer type

Timer No.

Sum scale

\Variable constant

Constant number
Constant
W001

W100

Reset

Rolling average

On/Off

Interval

Number of samples

\Alarm

First-CH

Last-CH

Level 1

On/Off

Type

\Math action settings

Value

Hysteresis

Logging

Output type

Output No.

Level 2

[on/off

Level 3

[on/off

Level 4

[on/off

Alarm delay

Hour

Minute

Second

\Display settings

First-CH

Last-CH

Tag

Characters

No.

Color

\Color

Zone

Lower

Upper

Scale

Position

Division

Bar graph

\Base position

|Division

Partial

On/Off

Expand

Boundary

Color scale band

Band area

Color

Display position Lower

Display position Upper

Alarm point mark

Indicate on Scale

Mark kind

Alarm 1 color

Alarm 2 color

Alarm 3 color

Alarm 4 color

|Logic math settings |

Value on Error
START/STOP key
action

Value on Overflow
SUM, AVE

MAX, MIN, P-P
Operation when PSUM
arithmetic overflows
[OVER/ROTATE

\Logic math number

Output

Output type

Output No.

Calculation expression

\Calculation expression

54

IM 04L51B01-02EN



Setup Menu Map

|Display settings |

\Trend interval

Trend interval [/div]

Trend rate switching

Second interval [/div]

\Group settings

\Group number

Group settings

On/Off

Group name

Channel set

Scale image

[on/off

Trip line 1

On/Off

Position

Color

Line width

Trip line 2

[on/off

Trip line 3

[on/off

Trip line 4

[on/off

\Message settings

\'“' ge number

Message

\Message 1

\Trend settings

Direction

Trend clear

Trend line

Grid

Scale

Digit

Value indicator

Digit of mark

Partial

[on/off

Message

Write group

Power-fail message

Change message

\Screen display settings

GX10/GP10 only.

N —

High speed.

Bar graph

\Direction

LCD

Brightness

View angle’

Backlight saver

Mode

Saver time

Restore

Monitor

Display background

Scroll time

Jump default display

Calendar display

\1st weekday

Changing each value
from monitoring

[on/off

Does not appear when the measurement mode is

3 Does not appear when the measurement mode is

Duall interval.

|Measurement settings |

Scan interval’

[Scan interval®

Over-range

\Value on over-range

Select unit

4
5

[Main unit, Unit 1 to 6

[Module 0-95 |

Operation mode

\Operation mode

A/D integrate®

A/D integrate®

Noise rejection?

Noise rejection?

General signal

Lower limit of burnout
set

Upper limit of burnout
set

Chattering filter for
pulse input*

[on/Off

Does not appear when the measurement mode is

Duall interval.

Appears when the GX90XA type is -HO and with PID

control modules.

Does not appear with high-speed Al or PID control

modules.

Pulse input module only

Does not appear with AO or DO modules.

When the measurement mode is set to dual interval

|Dua| interval settings |

‘Scan interval

Scan interval

Measurment group 1

Measurment group 2

Master scan interval

Measurment group
number

Module scan interval

[Main Unit, Unit 1 to 6

Module 0 to 9

Measurment group
number

Module 1

Measurment group

number

Module 9

Measurment group
number

\Recording settings

Recording mode

\File type

Event
data(Measurment
group 1)

Recording interval

Recording mode

Data length

Pre-trigger

Trigger source
operation

Event
data(Measurment
group 2)

Recording interval

Recording mode

Data length

Pre-trigger

Trigger source
operation

Continued on the next page
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Record confirmation
action

\Confirmation screen

Recording channel
settings

|Recording settings*

Measurment group 1

\ Event data

Measurment group 2

\ Event data

Manual sample

\Manual sample

Basic settings

Recording mode

[File type

Display data, Trend
waveform

\Saving interval

Event data

Recording interval

Recording mode

Data length

Pre-trigger

Trigger source
operation

Record confirmation
action

\Confirmation screen

*

Recording channel
settings

Dual interval.

|Data save settings |

Save directory

Display data, Trend
waveform

Event data

Manual sample

Does not appear when the measurement mode is

\Directory name

File header

\Characters

Data file name

\ Structure

\Identiﬁed strings

Media save

Auto save

Media FIFO

File format

\Display / Event data

|Batch settings

Batch function

On/Off

Lot-No. digit

Auto increment

Batch text

‘Batch text

\Text field number

Text field

Title of field

Characters

On a GX/GP with the multi-batch function (/BT option) with
the function enabled

|Batch settings

Batch function

On/Off

Lot-No. digit

Auto increment

Batch-specific settings

\ Batch text

Batch group number \
Text field number |
Text field

Title of field
Characters

\Group text

Batch group number \
Group number \
Group settings
On/Off

Group name
Channel set
Scale image
[on/off

Trip line 1
On/off
Position

Color

Line width

Trip line 4
On/Off
Position
Color
Line width

\Data save settings

Batch group number \
File header

\Characters \
Data file name
\Structure \
\Identified strings \

Recording start screen

Recording start screen

|Report settings

\Basic settings

Type

[Type

Creation time

Day

Day of week

Hour

Minute

Save interval

File creation interval
Data type

Report 1

Report 2

Report 3

Report 4

Report 5

File type

\ File type \
Report template output
Excel file

PDF file

Printer

Continued on the next page
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Electronic signature
PDF electronic
signature

Text file

Batch information
output

\Report channel settings

|Timer settings

Timer

Report channel number\
Report channel
Channel type
Channel no
Sum scale

\Timer 1

Type

[Type |
Interval

Day

Hour

Minute

Interval

Action on Math Start
\Reset \
Reference time

\Hour \
\Minute \

Timer 2

Timer 12

Match time timer

\Match time timer 1

Type

[Type

Timer match condition
Month

Day

Day of week

Hour

Minute

Timer action

\Timer action

Match time timer 2

Match time timer 12

|Event action

\Event action number

Event action

[on/off

Event

Type

Number

Event details

Operation mode

Action

Type

Number

Detail

Group number

Batch group number

When a PID control module is installed

|Control event action

Control event action
number

DI/DO/Internal switch
registration

Type

Number

Operation/Status
output

Content

Detail 1

Number

Detail 2

Number

Only on GX/GPs with the /AH Aerospace heat treatment

|Ca|ibration remineder settings

\Schedule number

Reminder function

[on/off

Due date

Due date

Daily reminder

Re-natification cycle

Notification contents

Title

Notification message1

Notification message2

Buzzer

Display settings for
date setting

Calibration correction
setting

Communication
channel settings

[On/Off, Span

First-CH
Last-CH
On/Off, Span
On/Off
Decimal place
Span Lower
Span Upper
Unit

At power on
\Value at power on \
Preset value

\ Preset value \
Watchdog timer
On/Off

Timer

Value at timer-expired

\Alarm

First-CH |
Last-CH |
Level 1
On/Off
Type

Value
Hysteresis
Logging
Output type
Output No.
Level 2
[on/off |
Level 3

[on/off |
Continued on the next page
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Level 4

[on/off

Alarm delay

Communication (Ethernet)
settings

Hour

Minute

\Basic settings

Second

\Display settings

First-CH |

Last-CH |

Tag

Characters

No.

Color

Color

Zone

Lower

Upper

Scale

Position |

Division \

Bar graph

Base position

Division

Partial

On/Off

Expand

Boundary

Color scale band

Band area

Color

Display position Lower

Display position Upper

Alarm point mark

Indicate on Scale

Mark kind

Alarm 1 color

Alarm 2 color

Alarm 3 color

Alarm 4 color

Automatic IP settings

\Obtain IP address automatically

IP Address

IP Address

Subnet mask

Default gateway

Automatically DNS settings

\Obtain DNS address automatically

DNS settings

Primary DNS server

Secondary DNS server

Domain suffix

Primary domain suffix

Secondary domain suffix

Host settings

Host name

Domain name

Host name registration

\Host name registration

\FTP client settings \

FTP client function

[on/Off

Transfer file

Display & Event data

Report

Manual sampled data

Alarm summary

Snap shot

Setting file'

Transfer wait time

Display & Event data

Report

Encryption

Encryption

Verification of certificate

FTP connection Primary

FTP server name

Port number

User name

Password

Directory

PASV mode

FTP connection Secondary

FTP server name

Port number

User name

Password

Directory

PASV mode

\SMTP client settings \

SMTP client function

[on/Off

Authentication

\Authentication

Encryption

Encryption

Verification of certificate

SMTP server

SMTP server name

Port number

User name

Password

POP3 server

POP3 server name

Port number

User name

Password

Continued on the next page
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E-mail settings \
Mail header
Recipient 1
Recipient 2
Sender

Subject

E-mail contents
Header

Include source URL
Alarm settings
Alarm notification
Detection
Channel set
Alarm level 1

Alarm level 4

Attach instantaneous data
Send alarm action

Include tag/ch in Subject
Report settings

\Report notification

Scheduled settings
Scheduled notification

Attach instantaneous data
Interval (Recipient 1)

Ref. time hour (Recipient 1)
Ref. time minute (Recipient 1)
Interval (Recipient 2)

Ref. time hour (Recipient 2)
Ref. time minute (Recipient 2)
System settings

Memory full notification
Power failure notification
System error notification
Notification of user lockout'

\SNTP client settings \
SNTP client function
[on/off

SNTP server

SNTP server name

Port number

Query action

Ref. time (Hour)

Ref. time (Minute)

Interval

Timeout

Time adjust on Start action

\Modbus client settings \
\Basic settings \
Modbus client function

Register
Channel type
First-CH
Last-CH

\WT connection client settin,

gs \

\Basic settings

WT connection client function

[on/oft |
Communication

\ Interval ‘
Recovery action

\Wait time \

\WT server setting

s \

\Server number \
WT server settings
On/Off

Server name
Model name

\WT data allocation settings \

\Allocation No

WT data allocation setting
On/Off

Server No

Data group name

Data name

Exponential scaling
Communication channel

[on/Off

Communication

\Interval

Recovery action

\Wait time

Connection

Keep connection

Connection timeout

\Modbus server settings \

\Server number

Modbus server settings

Server name

Port number

Continued on the next page

\Command settings \

[SLMP client settings *

\Basic settings

SLMP client function
[on/off |
Data code

\Data code \
Communication

\Interval \
Connection

\Communication timeout \
Recovery action
Recovery time

‘SLMP server setti

ngs \

\Server number
SLMP server settings
Server name

Port number

\Command setting

s |

\Client commnad number
Commnad settings

Type

Server

Request destination network No.
Request destination station No.
Request destination unit 10 number
Request destination multidrop
station No.

Device code

First device number

Data type

Channel type

First-CH

Last-CH

\Client command number

Command settings

Type

Server

Unit No.

Data type

[KDC client settings’

KDC connection Primary
Server name

Port number

KDC access point Secondary
\Server name \
\Port number \
Continued on the next page
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Certification key

Host principal

Realm name

Communication(Serial)
settings

Password

Encryption

\Server settings \

\ Sever function \
Keep alive function

[on/Off

Timeout function

[on/Off

\Timeout (minute)

FTP server

\Output Directory Format

Modbus server

\Modbus delay response

\Allowed Modbus clients \
Modbus client connect limits function

[on/Off

1

On/Off

IP Address

10

On/Off

IP Address

\Server list

FTP

On/Off

Encryption

Port number

HTTP

On/Off

Encryption

Port number

SNTP

On/Off

Port number

MODBUS

[on/Off

\Port number

GENE

On/Off

Port number

EtherNet/IP®

[on/Off

DARWIN

[on/off

\Channel conversion

OPC-UA®

On/Off

Port number

\Web content selection \
User level: User

DO channel status/COMM status, etc.

Log

System information/Network information

File

User level: Monitor

DO channel status/COMM status, etc.

Log

System information/Network information

File

On a GX/GP with the advanced security function (/AS
option) with the function enabled

Only on GX/GPs with the /E2 WT communication
option.

Only on GX/GPs with the /E1 EtherNet/IP
communiction option.

Only on GX/GPs with the /E4 SLMP communication
Only on GX/GPs with the /E3 OPC-UA server.

\Basic settings
Receiver
Function
Address
Data transfer
Baud rate
Parity bit
Stop bit

Data length
Handshake
Logout

\Auto logout \
DARWIN

\Channel conversion \

\Modbus master \
\Basic setting

Master function

[on/off

Communication

Interval

Communication timeout

Gap between messages

Recovery action

\Retransmission

\Wait time

\Command settings \

\Master command number

Command settings

Type

Slave

Data type

Register

Channel type

First-CH

Last-CH
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System settings |

Environment
(Language) settings

Language
Temperature
Decimal Point Type
Date format

Date format
Delimiter

Month indicator

\Alarm basic settings

Rate of change
\Decrease \
\Increase \
Indicator

[Hold/Nonhold |
Alarm ACK

\ Instruments tag

Instruments tag
Instrument tag No.

[Setting file

\Setting file comment \
Configuration change
comment’

\ Input comment \

‘USB input device

|USB input device |

1 On a GX/GP with the advanced security function (/AS
option) with the function enabled.

[Individual alarm ACK |

\Time basic settings

Time zone

Hour

Minute

Gradually adjusting
the time

Time deviation limit
Time adjustment
beyond limit

Daylight Saving Time
\Use/Not \
Start time
Month

Day order

Day of the week
Hour of the day
End time

Month

Day order

Day of the week
Hour of the day

\Internal switch settings

First number

Last number

Internal switch

Type

And/Or

Preset action

\At power on

\Status relay

Fail relay

Memory/Media status

Measurement error

Communication error

Record stop

Alarm

\Printer settings

IP Address

Paper size

Page orientation

Resolution (dpi)

Number of copies

Snapshot

Paper size indicator

[Sound, LED

Sound

Touch

Warning

LED

[MENU key LED

|Securit¥ settings

\Basic settings

Security function

Touch operation
Communication

Logout

Auto logout

Operation without
Login

Password management
On/Off

Root user password
Password retry
\Password retry \
User ID'

[on/off |

\User settings

User number \
User settings

User level

Mode

User name

User ID'

Initialize password
Password expiration’
User property
Authority number
Sign in property’
Authority of signature’

\Authority of user

\Authority number \
Authority of user
Record

Math

Data save

Message

Batch

Alarm ACK
Communication
Touch operation

Time set

Setting operation
Calibration correction'
External media
System operation
Output operation
Remote/Local
operation?

Control operation?
Tuning operation?

SP operation?
Program operation®
Continued on the next
page
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\Operation Lock

Operation Lock function
\Password \
Limitations

Record

Math

Data save

M ge

Batch

Alarm ACK
Communication
Touch operation
Time set

Setting operation
Calibration settings '

External media

System operation

Output operation

Remote/Local
operation?

Control operation?

Tuning operation?

SP operation?

Program operation®

[Sign in settings

Sign in type

[Type |

Recording stop action

‘Sign in \

Data file transfer

\FTP transfer timing \

Sign in title

Signin 1

Signin 2

Signin 3

[Sign in property !

\Authority of signature \

Sign in property

Signin 1

Signin 2

Signin 3

1 On a GX/GP with the advanced security function (/AS
option) with the function enabled.

2 When a PID control module is installed.

3 When a PID control module and program control (/PG
option) is installed.

|Control settings |

Setup parameters

\Basic control settings \
Control period

\Control period

\Control basic operation

Unit Number \

Slot Number \

Basic action

Control mode

Input switching action

Restart mode

\Control loop settings

\Loop number

Basic action

Control type

PID initial value

PID selection

EXPV function

RSP function

PID control mode
Number of SP groups
Number of PID groups
Number of Alarms
Alarm mode

\Action settings

Unit Number

Slot Number

Action

AUTO/MAN Switch
(Loop1)

AUTO/MAN Switch
(Loop2)
REMOTE/LOCAL
Switch (Loop1)
REMOTE/LOCAL
Switch (Loop2)
STOP/RUN Switch
(Loop1)

STOP/RUN Switch
(Loop2)

Switch to Cascade
Switch to AUTO
(Loop1)

Switch to AUTO
(Loop2)

Switch to MAN (Loop1)
Switch to MAN (Loop2)
Switch to REMOTE
(Loop1)

Switch to REMOTE
(Loop2)

Switch to LOCAL
(Loop1)

Switch to LOCAL
(Loop2)

Auto-tuning START/
STOP Switch (Loop1)
Auto-tuning START/
STOP Switch (Loop2)
PV Switch

Alarm ACK (Loop1)
Alarm ACK (Loop2)
Bit-0 of SP Number
(Loop1)

Bit-1 of SP Number
(Loop1)

Bit-2 of SP Number
(Loop1)

Continued on the next
page
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Bit-3 of SP Number
(Loop1)
Bit-0 of SP Number
(Loop2)
Bit-1 of SP Number
(Loop2)
Bit-2 of SP Number
(Loop2)
Bit-3 of SP Number
(Loop2)
Bit-0 of PID Number
(Loop1)
Bit-1 of PID Number
(Loop1)
Bit-2 of PID Number
(Loop1)
Bit-3 of PID Number
(Loop1)
Bit-0 of PID Number
(Loop2)
Bit-1 of PID Number
(Loop2)
Bit-2 of PID Number
(Loop2)
Bit-3 of PID Number
(Loop2)

\DO settings

\ Input/Output settings \

Input settings

Unit Number
Slot Number
DO number
Range

[Type |
DO function selection
Type

Output

Action
Energize/De-energize
Action

Hold

Relay Action on ACK
Relay deactivated
interval

\Measurment input range

Unit Number
Slot Number
Al number
Range

Type

Range

Span Lower
Span Upper
Calculation
Scale

Decimal place
Scale Lower
Scale Upper
Unit

Low-cut
On/Off
Low-cut value
Low-cut output
RJC

Mode
Temperature
Burnout set
\Mode \
Bias

\Value \
Input filter
On/Off
Filter

\Calibration correction

Unit Number

Slot Number

Al number

Mode

Mode

Number of set points
1

Linearizer input
Linearizer output

12
\Linearizer input \
\Linearizer output

Setting when the mode is set to Correction Coefficient on a

module with an /AH option

Output settings

1
Uncorrected value
Instrument correction
factor

Sensor correction
factor

Execution of the input
measurement

12

Uncorrected value
Instrument correction
factor

Sensor correction
factor

Execution of the input
measurement

\ Re-Trans

Unit Number

Slot Number

AO number

Re-Trans

On/Off

Type

Minimum value of input
scale

Maximum value of
input scale

\Split computation

Unit Number
Slot Number
AO number
Mode
[on/oft |

Output 0% segmental
point

Output 100%
segmental point

\Output type

Unit Number

Slot Number

AO number

Output type

Type

Cycle time

Current output range
Continued on the next
page
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\PV, RSP settings \ \Target setpoint \
\Control PV input range \Loop number \
Loop number \ SP ramp-rate settings
Control PV input range Ramp-down rate
Decimal point Ramp-rate
Minimum value of input Ramp-up rate
range Ramp-rate
Maximum value of SP number 1
input range \Target setpoint \
Unit :
Input switching PV SP number 8
range \Target setpoint \
Input switching PV
low limit PID number/Reference
Input switching PV point
high limit Loop number |
SP number 1
[EXPV function | [PID number |
\Loop number :
EXPV SP number 8
Type [PID number |
Channel number Reference point
EXPV2 [Point 1 |
[Type | :
\Channel number \ \Point 8 \
RSP function Zone PID switching
Loop number \ hysteresis
RSP Reference deviation
Type On/Off
Channel number Reference deviation
Al terminal number
Remote input \PID settings
Input filter Loop number
Filter PID number
Input ratio
Ratio Proportional band
Input bias Integral time
Bias Derivative time
Control output low limit
[Output settings Control output high limit
Loop number \ Tight shut function
Preset output Manual reset
\Input error preset output \ Upper-side hysteresis
Output limiter switch Lower-side hysteresis
\On/Off \ Direct/Reverse action
switch
Operation parameters Preset output
\Control alarm \
|Loop number PID settings(Reference
Level 1 PID)
On/Off Loop number \
Type
Stand-by action Proportional band
Hysteresis Integral time
On-delay timer (minutes) Derivative time
On-delay timer Control output low limit
(seconds) Control output high limit
Off-delay timer (minutes) Tight shut function
Off-delay timer Manual reset
(seconds) Upper-side hysteresis
Relay action/behavior Lower-side hysteresis
PV velocity alarm time Direct/Reverse action
setpoint (minutes) switch
PV velocity alarm time Preset output
setpoint (seconds)
: \Control detail settings
Level 4 Loop number \
\ On/Off \ Tracking
\SP tracking \
\Value \ \PV tracking \
[SP number | SP limit
Low limit
\Alarm level 1 setpoint \ High limit
: SP ramp-rate time unit
[Alarm level 4 setpoint | [Unit
Continued on the next page
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Control display )
Control group settings

Output velocity limiter

On/Off
Value

Auto-tuning

Type

Output low limit

Output high limit

SP bias

Anti-reset windup

Type

Value

Overshoot suppressing
function

\Super function

Group number

Group settings

Group On/Off

Group name

Division

1

On/Off

Loop number

8

On/Off

Loop number

\Loop display settings

Loop number

Tag

\Characters

\No.

Color

\Pattern Color

Deviation display band

\Deviation display band

\PID channel settings

Channel no

Tag

Characters

No.

Color

\Color

Zone

Lower

Upper

Scale

\Position

|Division

Bar graph

Base position

Division

Partial

On/Off

Expand

Boundary

Display characters of
each value

0

1

\Screen display settings

Display background

Manual output operation
type

Program pattern
settings

Program Run/Reset
message

Automatic switch to
program operation
display

Program RUN detail
settings

\Editing Prgram Pattern ‘

Program pattern EDIT menu

|Initial settings |

\Pattem initial settings

Pattern name
Number of loops used
Action loop

\Loop 1 \

\.Loop 20 \

Program starting
conditions

Starting target setpoint
\ Loop 1

\.Loop 20 ‘

Start code
Reference loop number

\Wait function settings

Zone number \
Loop 1

Wait function
Lower-side wait zone
Upper-side wait zone

Loop 20

Wait function
Lower-side wait zone
Upper-side wait zone
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|Segment settings |

\Program pattern setting \
\Segment number \
Target setpoint
\Loop 1 \

\i_oop 20 \
Segment time
\Time \

Segment PID number
selection
Junction code

\Time Event settings \

\Segment number
Time Event 1
Starting condition
On time
Off time

Time Event 32
Starting condition
On time

Off time

\PV Event settings \

\Segment number
PV Event 1
Loop number
Type
Value

PV Event 32
Loop number
Type
Value

\PV Event hysteresis \
Hysteresis
[PV Event 1 |

“3V Event 32 \

\Insert/DeIete segment

Segment number \
Insert/Delete segment \

\ Execute \

Repeat function
settings

Repeat function
settings

Repeat function
Number of repeat
cycles

Repeat cycle start
segment number
Repeat cycle end
segment number

|Event display group |

Event display 1
Display

Event type
Event number

Event display 10
Display

Event type
Event number
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YOKOGAWA ELECTRIC CORPORATION

Headquarters
9-32, Nakacho, 2-chome, Musashino-shi, Tokyo, 180-8750 JAPAN
Phone : 81-422-52-5555

Branch Sales Offices
Osaka, Nagoya, Hiroshima, Kurashiki, Fukuoka, Kitakyusyu

YOKOGAWA CORPORATION OF AMERICA

Head Office
12530 West Airport Blvd, Sugar Land, Texas 77478, USA
Phone : 1-281-340-3800 Fax : 1-281-340-3838

Georgia Office
2 Dart Road, Newnan, Georgia 30265, USA
Phone : 1-800-888-6400 Fax : 1-770-254-0928
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Phone : 31-88-4641000 Fax : 31-88-4641111
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